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WHY THIS eBOOK?
Now that the eBook Revolution is in full 

swing, it is interesting for us to finally have 

a more public medium for our eBooks. 

We have specialized in interactive eBooks 

for digital photography since the year 

2000 and this is our 19th publication in 

approximately this form.

Yet, this volume is somewhat experi-

mental. With the release of Apple’s iPad, a 

new era of eBooks is upon us. iPad users can 

play PDF files within Apple’s iBooks app.

Previous PDF eBooks allowed embed-

ded movies and photos that could 

change with a mouse move plus audio 

files one could click and play on comput-

ers only. The PDF reader on your iPad 

offers a different sort of interaction, but it 

is fast, intuitive and easy to control.

Our Lights, Digital Camera, ACTIONS! 

eBook appeared in 2008. Photoshop then 

was only up to version CS3. Today, Pho-

toshop is up to CS5. Its Actions capability 

has reached new levels of maturity and 

functionality. As a Beta Tester, I worked 

with the Adobe team, championing some 

of the functions that made it into the 

final CS5 version. All of the Photoshop 

Actions in this eBook have been written, 

re-written or tested with Photoshop CS5.

Actions are recorded sequences of 

Photoshop steps. If I showed you an 

interesting process with more than about 

five sequential steps, a month from now 

you would no longer be sure you remem-

bered them exactly, but an Action would 

remember them for you, precisely.  

Some iNovaFX Photoshop Actions are 

literally hundreds of 

steps long—far beyond 

what is reasonable to 

memorize, so Actions are 

a way of orchestrating 

complex new “features.”

With CS5, the rate of 

Action replay has been 

accelerated. For both 

Mac and Windows platforms, Pho-

toshop CS5 can operate in a speedy 

64-bit mode. See your Photoshop docs 

for instructions in setting this up.

SOFTWARE INCLUDED
Our Action software comes with this 

volume, and that’s the collection of 

Photoshop CS5 Actions that you must 

install into your copy of Photoshop so 

you can achieve the things you see in 

this document. Most will work with CS4 

and earlier versions of Photoshop as well.

Photoshop Actions in this eBook are all 

original. All begin with a lower-case “i.” 

Some execute quickly; others take 

several minutes, depending on the func-

tions and number of steps they employ. 

A few will stop midstream, waiting for 

you to provide personal input. 

Often you won’t know precisely what 

an Action will generate until you’ve 

tried it several times, or with several 

different images. After a while, the 

Actions begin to feel 

like large, complex 

Photoshop tools, each 

delivering a larger, more 

complex result than you 

get from Photoshop’s 

usual tools, filters and 

functions alone.

Most Actions deliver a 

labeled Snapshot into the History Panel. 

If you don’t have the History Panel visible, 

you can light it up through the Windows 
> History command that appears in the 

Header Bar.

In this eBook, the Actions are 

designed to work with just about any 

image from 6MP (about 3000 x 2000 

pixels) to 24MP (6000 x 4000), and 

many will work seamlessly with shots 

as small as 4MP and larger than 50MP.

Sometimes the image will be scaled to a 

standard larger size before the heavy work 

begins. That might result in a file much 

bigger than the original, so you may wish 

to scale images back to near-original size 

before saving the result. A few Actions may 

reduce the original image to a smaller size 

before processing, but only if the original is 

extraordinarily large.  We have tried to hit 

a balance between final pixel dimensions 

and prudent processing times.

There is no real limit to the number of 

steps that can be applied to an image, so 

some of our Actions dump the memo-

rized steps that fill up the History Panel on 

the fly during processing. 

You can limit the number of steps 

that Photoshop tries to keep track of by 

opening Preferences > Performance > History 
& Cache > History States > # and filling in any 

number. To keep memory lively, put in a 

lower number of History States. Try 10. To 

be able to retrace your steps more deeply, 

you might try 100.

You won’t find the Actions inside the 

eBook. They are software files in a folder 

called CS5Actions. There you will see over 

101 folders, each of which holds between 1 

and 30 different Actions. 

Loading Actions is easy. You may load 

them by dropping an Action’s icon onto 

the Photoshop program icon or alias. Or 

use the Actions Panel’s own attached 

Load Actions menu function.

Bon Aperture,

Peter iNova, November, 2010

FOREWORD/FORWARD If your practice of photography does not involve amplifying your 
images—quick: close this volume and step away from the computer 
with your hands in the air—nobody will get hurt.
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GETTING THE MOST FROM THIS EBOOK
You’re in the Twilight Zone of 
written publications. The signpost 
up ahead says eBook, but the 
definition of that is not resolved. 
Here’s our map.

This eBook is a ginormous PDF 
file, and reads directly within Adobe 
Reader on your computer or through 
the iBooks reader on your iPad.  It’s 
big because the images are extraor-
dinarily high resolution. (A smaller, 
lower-resolution ActionsCS5-Fast file 
moves quicker on the iPad.)

PDF means Portable Document 
Format, and Adobe invented it in the 
1990s as a cross-platform standard 
allowing text and images to play on a 
computer screen with color, interac-
tion, instant jumping around and 
instant linking to the Internet. 

Most PDF files that you download 
from the Internet are relatively small, 
with low-quality images and limited 
resolution. Say goodbye to all that. 
This volume lets you expand images 
up to full screen to study the picture 
closer than any printed book.

iPad viewing allows extreme 
enlargement. Just double tap 
on an image to have it zoom up 
to as big as it can get without 
cropping. This CS5-based revision 
concentrates on making iPad 
viewing straightforward and easy to 
negotiate. 

Since the subject here involves 
Adobe Photoshop CS5 (often written 
as PS CS5), the eBook is just a mouse 
click away from the subject matter 
when viewed on your computer. 
And for reading on your iPad, it goes 
anywhere;  from the loo to Timbuktu. 

We encourage you to read about 
an Action, then wonder if it is useful 
to your type of photography for a 
while, then experiment with it several 
times before using it for something 
important. 

You will need Adobe Reader 9 or 
greater to experience this eBook on 
your computer.  Your iPad will need 
a PDF reader, too. Apple’s own iBook 
app loads any PDF files through 
iTunes. In iTunes, an attached iPad 
shows its contents under a dedicated 
Books header where you can view all 
PDF volumes by icon or by name.

Variations on Adobe Reader for PC’s 
are free for Windows, Mac and Linux 
operating systems, but Photoshop 
is only available for Windows and 
Macintosh computers, so you are 
likely in one of those two platforms. 

The eBook files and Actions are 
compatible with all forms of Macin-
tosh OS X and Windows that can 
accommodate Photoshop CS5. Many 
Actions will work with older versions 
such as CS4 and CS3.

THUMBNAIL BROWSING
The thumbnails running down the 

left side of the Adobe Reader page 
on a computer work well as a quick 
finder. Adobe Reader 9 tabs this 
feature under the title Pages while 
some prior versions call it Thumbnails.  
Viewing on iPads doesn’t show 
these thumbnails, rather they’ve 
become a scroll line along the 
bottom of the page.

Thumbnails give you a chance to 
scan the eBook pages fairly quickly 
and spot any page that looks familiar. 
Click on any page for an instant 
jump to it at the current viewing 
magnification. You can enlarge, shrink 
or eliminate thumbnails to conserve 
screen space.

A Bookmarks tab at the left of the 
Reader page image is a sort of mini 
table of contents. Click on any of its 
listed items and jumping to that page 
will be instantaneous.

Note that Reader behaves much like 
an Internet browser and arrows in 
the header will navigate forward and 
backward through a string of your 
most recent interactive jumps.

PRINTING OUT
You can print out ranges of pages 

from your computer in black and 
white, with a laser printer, or in color, 
with an ink-jet printer, any time you 
wish for reference.

Hint: to print a range of pages, 
highlight the first page, shift-click 
the last and use Reader’s Print Range 
feature.

INTERNET UPDATES
It is inevitable. Data in a timely 

document like this may give way to 
new information, become obsolete, 
or acquire new meanings as technol-
ogy progresses. 

After reading through this eBook 
you may wish to visit our special site 
holding updated information, links, 
special offers, new techniques, bonus 
Actions and the latest information, 
along with any errata and corrections.

http://www.digitalsecrets.net/ActionsCS5/

http://www.digitalsecrets.net/ActionsCS5/
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THREE HINTS FOR THE NEW PHOTOGRAPHY
Aw, you missed it!
Liquids, dryers, the smell of exotic chemicals, the 
finger discoloration, nay, the shirt stains that no 
dry cleaner could erase. Ah, the golden days of 
photography where discovering that you got the 
exposure all wrong was merely an hour into the 
future or a day too late...

Today’s DSLR cameras can move you from being 

a newcomer to being a photographic artist. The 

great photographers from the past would have 

exchanged body parts for today’s gear if you 

could send it back in a time machine. 

Ansel Adams lived long enough to experience 

the first rays at the dawn of electronic photogra-

phy, and he knew that cameras like these would 

be in our future. He smiled in envy of you. So, 

welcome to the expanding world of images as 

seen by a computer with a lens attached.

At its heart, a digital camera is all about count-

ing. They count the number of photons from 

the real world and give back numerical images 

from the computer world. Between those two 

extremes, you get to intervene and decide what’s 

Good, Bad or Ugly. 

HINT #1: Throw away the Ugly, improve the Bad 

and learn from the Good.

All the historical principles of photography are 

still there—except the ones about wet darkroom 

stains. We still need to pay attention to shutter 

speeds, sensitivity to light, color balance, aperture 

settings, framing the image, composing the 

picture and understanding how those all work. 

But like magic, as soon as you shoot a picture, you 

get to review it at a decent size. If it displeases 

you, erase it. Put down the image and step away 

from the shot.

����

HINT #2: Reviewing via the monitor is your first 

line of defense from the Bad and Ugly. 

By arming yourself with a wide range of digital 

possibilities, you can think of that review image 

as a starting place for things you can accomplish 

later. Where film photographers 

from the past were required to take 

their images through the darkroom, 

you have your laptop or desktop 

computer in which you can store, 

manipulate, correct and improve your images in a 

near infinite number of ways.

Think of this as a dimroom—just enough light 

control to let you see the computer screen. It’s the 

place that differentiates the snap-shooter from the 

photojournalist, the portrait photographer and the 

photographic artist.  People who take photography 

seriously revisit their images the way Adams 

did—always thinking of ways to make the original 

moment into compelling memory.

HINT #3: Much of photography is about the 

subject, but most of it is about the photographer.  

Your role—Eye of the Beholder—is involved at 

every level, so here are hundreds of extra ways of 

beholding.
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Learning Examples
iCrAb-series . . . . . . . . . . . . .             26

Chromatic Aberration reduction 
reviewed as part of a general 
explanation of how Actions work.

	 (32 associated detail Actions*)
iBC-DIY . . . . . . . . . . . . . . . . .                 43
	 Barrel and pincushion distortion 

Action making as an example for 
learning how Actions work.

	 (You make 1 Action)
iCrosstar-DIY. . . . . . . . . . . . .             49
	 Hands-on crosstar complex Action 

making. (You make 1 Action)
iTelePanoBlend. . . . . . . . .         176
	 Demonstration of Photomerge with 

included pano segments. (1 Action)
iPerspectiveTutor. . . . . . . .        182
	 Guided tutorial on perspective 

correction geometry. (2 Actions)

Border Crossings . .  .  .  .  .  .  .  .  .  .  59
	 Actions that create frames, film 

borders and graphic containers for 
images.

iFilmBorders . . . . . . . . . . . . .             61
	 Simulated roll film and 6x6 borders 

with edge text and roll fog options.
	 (9 Actions)
	 Simulated 4x5 H and V sheet film 

borders with margin text.
	 (2 Actions + 2 Crop utilities)

iFilmBorders35 . . . . . . . . . . .           68
	 Simulation of accurate 35mm single 

frame chip. Two different versions 
plus margin title generators for 
CS2/CS3.

	 (19 Actions plus 8 prep utilities)
iStampBorders. . . . . . . . . . .           69
	 Graphic perforated stamp borders in 

three sizes.
	 (5 Actions)
iFourPrint. . . . . . . . . . . . . . . .                70
	 Page layout that combines any four 

images into a single sheet horizontal 
and vertical 3x4 & 2x3 variations.

	 (4 Actions)
iMulti16. . . . . . . . . . . . . . . . .                 72
	 Page layout that combines any 

16 images into a single sheet. 
Horizontal, vertical, twisted and 
dimensional variations.

	 (6 Actions + utilities/info) 

Photoshop Filters +++. .  .  .  .  .  .  .  75
iPSArtistic-Series. . . . . . . . . .          77
	 iColorPencilWhite (1) . . . . . . . . .        77
	 iColorPencilGray (1). . . . . . . . . .         78
	 iDryBrush (1). . . . . . . . . . . . . . . .               79
	 iDryBrushG (1) . . . . . . . . . . . . . .             80
	 iFilmGrain1 / 2 (2). . . . . . . . . . . .           81
	 iFresco (1) . . . . . . . . . . . . . . . . . .                 82
	 iNeonGlow1 / 2 (2) . . . . . . . . . . .          83
	 iPaintDaubs (1). . . . . . . . . . . . . . 84
	

	 iPaletteKnife (1). . . . . . . . . . . . . .             85
	 iPlasticWrap (1). . . . . . . . . . . . . .             86
	 iPoster (1). . . . . . . . . . . . . . . . . . .                  87
	 iRoughPastelsBoard (1). . . . . . . .       88
	 iRoughPastelsCanvas (1). . . . . . .      88
	 iSmudgeStick (1). . . . . . . . . . . . .            89
	 iSponge (1). . . . . . . . . . . . . . . . . .                 90
	 iUnderpainting (1). . . . . . . . . . . .           91
	 iWatercolor1 (1). . . . . . . . . . . . . .             92
	 iWatercolor2 / 3 (2). . . . . . . . . . .          93
 	 (21 Actions)
iPSBrushstrokes-Series . . . . .     95
	 iAccentedEdges (3) . . . . . . . . . . .          95
	 iAngledStrokesLg (1). . . . . . . . . .         96
	 iAngledStrokesPortrait (1). . . . . .     97
	 iAngledStrokesSm (1). . . . . . . . .        98
	 iCrosshatch (1). . . . . . . . . . . . . . .              99
	 iDarkStrokes (1). . . . . . . . . . . . .            100
	 iInkOutlines (1) . . . . . . . . . . . . .            101
	 iSpatter (1). . . . . . . . . . . . . . . . .                102
	 iSprayedStrokes (1). . . . . . . . . .         103
	 iSumi-E (1). . . . . . . . . . . . . . . . .                104
	 (12 Actions)
iPSDistort-Series . . . . . . . . .         105
	 iDiffuseGlow1 / 2 / 3 (3). . . . . .     105
	 iGlassRipple (1). . . . . . . . . . . . .            106
	 iOceanRipple (1) . . . . . . . . . . . .           107
	 iPinch (4). . . . . . . . . . . . . . . . . .                 108
	 iSpherize (4). . . . . . . . . . . . . . . .               109
	 iRipple (1) . . . . . . . . . . . . . . . . .                110
	 iShear (2). . . . . . . . . . . . . . . . . .                 111
	 iTwirl (2) . . . . . . . . . . . . . . . . . .                 112
	

	 iWave (2). . . . . . . . . . . . . . . . . .                 113
	 iZigAround (1). . . . . . . . . . . . . .             114
	 iZigCenter (1). . . . . . . . . . . . . . .              115
	 iZigPond (1). . . . . . . . . . . . . . . .               116
	 (23 Actions)
iPSPixelate-Series. . . . . . . .        117
	 iColorHalftoneL / T (2). . . . . . .      117
	 iBWHalftoneT (1) . . . . . . . . . . .          117
	 iCrystalize (1). . . . . . . . . . . . . . .              118
	 iPointillizeSeurat (2) . . . . . . . . .        119
	 (6 Actions)
iPS+Noise-Series. . . . . . . . .         120
	 iMedian (1). . . . . . . . . . . . . . . . .                120
	 iDust/Scratches (1). . . . . . . . . . .          120
	 (2 Actions)
iPSSketch-Series. . . . . . . . .         121
	 iBasRelief (1). . . . . . . . . . . . . . .              121
	 iBasReliefColor (2) . . . . . . . . . .         121
	 iChalkNcharcoal (1). . . . . . . . . .         122
	 iChalkNcharcoalColor (1). . . . .    123
	 iCharcoal (1). . . . . . . . . . . . . . . 123
	 iCharcoalColor (1). . . . . . . . . . .          123
	 iChrome / iChromeChroma (2). 124
	 iContéCrayon1 / 2 (2). . . . . . . . 125
	 iContéCrayon3 / 4 (2). . . . . . . . 126
	 iContéCrayonColor (1). . . . . . . 127
	 iGraphicPen (2) . . . . . . . . . . . . .            128
	 iGraphicPenColor (2). . . . . . . . .        129
	 iPhotoCopy (1). . . . . . . . . . . . . .             130
	 iPhotoColorCopy (1). . . . . . . . .        131	

iReticulation1 / 2 / 3 (3+Carnet).132
	 iReticulationColor (1) . . . . . . . .       133
	

 Meet the Actions
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iPSSketch-series. . . . . . .      (continued)

	 iStamp (1). . . . . . . . . . . . . . . . . .                 134
	 iStampColor (1). . . . . . . . . . . . .            135
	 iTornEdges (1). . . . . . . . . . . . . .             136
	 iWaterPaper (2) . . . . . . . . . . . . .            137
	 (30 Actions)
iStylize-Series. . . . . . . . . . . .            138
	 iEmboss (1) . . . . . . . . . . . . . . . .               138
	 iEmbossColor (1). . . . . . . . . . . .           138
	 iExtrudeChalk (1). . . . . . . . . . . .           139
	 iExtrudePlanks (1). . . . . . . . . . .          140
	 iExtrudeSpikes (2). . . . . . . . . . .          141
	 iFindEdges (5). . . . . . . . . . . . . .             142
	 iGlowingEdgesA / B (2). . . . . . 143
	 iGlowingWindL / R (2). . . . . . .      144
	 iFindEdgesCarnet (1)
	 iGlowingCarnet (1)
	 (17 Actions)
iPSTexture-Series. . . . . . . . .145
	 iCraquelureA (1) . . . . . . . . . . . .           145
	 iCraquelureB / C (2). . . . . . . . . .         146
	 iMosaicPatchwork (2) . . . . . . . .       147
	 iStainedGlass (1) . . . . . . . . . . . .           148
	 iStainedGlass+ (1). . . . . . . . . . .          159
	 iTexturizer (3) . . . . . . . . . . . . . .             150
	 (10 Actions)

iFilterFantastics. .  .  .  .  .  .  .  .  151
	 iGradA (11) . . . . . . . . . . . . . . . .               153
	 iGradB-Contrast (1). . . . . . . . . .         155
	 iGrad2Taste (1) . . . . . . . . . . . . .            156
	 iFog (5). . . . . . . . . . . . . . . . . . . .                   157
	 iDiffuse (4). . . . . . . . . . . . . . . . .                158

	 iHalo (9). . . . . . . . . . . . . . . . . . .                  159
	 iCrosstar (9). . . . . . . . . . . . . . . .               160
	 iScratchStar (3). . . . . . . . . . . . . 161
	 iPolarizeSkyFX (15). . . . . . . . . 162
	 iIRbw (3) . . . . . . . . . . . . . . . . . .                 163
	 iShatter (3). . . . . . . . . . . . . . . . .                164
	 iShatter++ (1). . . . . . . . . . . . . . .              165
	 iBaby (4). . . . . . . . . . . . . . . . . . 166
	 iToy (5). . . . . . . . . . . . . . . . . . . 167
	 iFocusMeCS5 (3). . . . . . . . . . . .           168
	 iFocusInteractive3 (1) . . . . . . . .       169
	 iVignette (4). . . . . . . . . . . . . . . .               170
	 (82 Actions)

Corrective Measures. .  .  .  .  .  .  .  171
	 iBCGeneral (barrel dist) (20). . .  174
	 iBCCorner (4). . . . . . . . . . . . . . 175
	 iBCMulti H / V batch (40). . . . .    176
	 iPanoCylinderEdges (14). . . . . .     177	

iPerspectiveTutor (2). . . . . . . . .        181
	 iCCMetrics (23). . . . . . . . . . . . .            184
	 iCCMisc (10). . . . . . . . . . . . . . .              184
	 iSodium (7) . . . . . . . . . . . . . . . .               185
	 iCFCooler-Warmer (2). . . . . . . .       185
	 iAerialShotCorrect (2). . . . . . . .       186
	 iDeJPEG (1). . . . . . . . . . . . . . . .               187
	 iDeNoise (6). . . . . . . . . . . . . . . .               188
	 iShadowLifts (13). . . . . . . . . . . 189
	 iSODSLR (12). . . . . . . . . . . . . .             190
	 iSOExtreme (6) . . . . . . . . . . . . .            191
	 iFlawFix (7). . . . . . . . . . . . . . . .               192
	 iDustAway (3). . . . . . . . . . . . . .             193
	 (176 Actions)
	

Artistic Conversions. .  .  .  .  .  .  .  195
	 iLiners (6). . . . . . . . . . . . . . . . . .                 196
	 iComplexArtFX 
		  iAngledStrokes (4). . . . . . . . .        197
		  iCanvasPainting (5) . . . . . . . .       198
		  iLandscape (3) . . . . . . . . . . . .           199
		  iWaterColor (3) . . . . . . . . . . .          200
		  iPencilSketch (1) . . . . . . . . . .         201
		  iPencilLine (1). . . . . . . . . . . .           202
		  iColorBlast (1). . . . . . . . . . . .           203
		  iColorDream (1). . . . . . . . . . .          203
		  iContrast (9). . . . . . . . . . . . . .             204
	 iDimroomArt
		  iLumiBloom (3) . . . . . . . . . . .          205
		  iBloomArt (3). . . . . . . . . . . . .            206
		  iFleshTona (1). . . . . . . . . . . . .            207
	 iToons (6). . . . . . . . . . . . . . . . . .                 208
	 iGraphic (6) . . . . . . . . . . . . . . . .               209
	 iCine-Like FX
		  iHalcyon (4) . . . . . . . . . . . . . .             210
		  iSinCity (5). . . . . . . . . . . . . . .              211
		  iJazzAge (3) . . . . . . . . . . . . . .             212
		  iDomino (4) . . . . . . . . . . . . . .             213
	 iRustica (3). . . . . . . . . . . . . . . . .                214
	 iBWColorFilters (13). . . . . . . . .        215
	 iBWFilmFX (7). . . . . . . . . . . . .            217	

iBWPrintTints (14) . . . . . . . . . .         218
	 (106 Actions)

Enhancements/Utilities. .  .  .  .  .  219
	 iDynamicRangers (9). . . . . . . . .        220
	 iFrameAverage (4). . . . . . . . . . .          221
	 iFrameAvgAutoAlign (5). . . . . .     224
	 iFrmAvgFullAA+CropCS5 (5). 224
	 iRegister (12). . . . . . . . . . . . . . .              224
	 iPanacea (3). . . . . . . . . . . . . . . .               225
	 iLayers (8) . . . . . . . . . . . . . . . . .                226
	 iCrop (7). . . . . . . . . . . . . . . . . . .                  228
	 iOldTymie (3). . . . . . . . . . . . . . 229
	 iRetinex (7). . . . . . . . . . . . . . . . 230
	 iBCFisheye (7). . . . . . . . . . . . . .             231
	 iDotsFX (7) . . . . . . . . . . . . . . . .               232
	 iCombo (4). . . . . . . . . . . . . . . . .                233
	 iHandyChanges (5). . . . . . . . . . 234
	 iChannelMixer (2). . . . . . . . . . .          235
	 iFingerPrint (4). . . . . . . . . . . . . .             237
	 iBubble (10). . . . . . . . . . . . . . . .               238
	 iFace (3). . . . . . . . . . . . . . . . . . .                  242
	 iButterfly (4). . . . . . . . . . . . . . . 243
	 iBannerImage (2). . . . . . . . . . . .           245
 	 (106 Actions)

 Meet the Actions (continued)
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Photoshop Extended. .  .  .  .  .  .  .  247
	 iPanoFromMovie (6). .  .  .  .  .  .  .  . 248
	 iSlit (1). .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 253
	 iSlitStreak (4). .  .  .  .  .  .  .  .  .  .  .  .  .  . 255
	 iSlitScan (2). .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 256
	 iVidGrad (1). .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 260
	 iVidBlur2 (1). .  .  .  .  .  .  .  .  .  .  .  .  .  . 261
	 iFlickerFixer (1). .  .  .  .  .  .  .  .  .  .  .  . 262
	 iTimeLapseMaker (1). . . . . . . . 262
	 iMovieStar & Lite (2). . . . . . . . 263
	 iVintageCS5 (4). .  .  .  .  .  .  .  .  .  .  .  . 264
	 iMovieToonsCS5 (3). .  .  .  .  .  .  .  . 265
	 iMovieCharcoal (2) . .  .  .  .  .  .  .  .  . 266
	 iMoveConté (3) . .  .  .  .  .  .  .  .  .  .  .  . 267
	 iMovieBrighten (3). . . . . . . . . . 268
 	 iMovieDarken (3). .  .  .  .  .  .  .  .  .  .  . 268	

iMovieGrade (10). .  .  .  .  .  .  .  .  .  .  . 269
	 iMovieDeNoise (3). . . . . . . . . . 274
	 iMovieTimeDNoise (2). .  .  .  .  .  . 275
	 iMovieSharpen (3). .  .  .  .  .  .  .  .  .  . 275
	 iMovieDotRemover   .  .  .  .  .  . 276
	 (56 Actions)
Total at press time. .  .  .  .  .  .  .  .  .  .  .  .  .  . 101 Folders
	 	 . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  704 Actions

Notes: 
	 Minor Actions are not counted.

	 * iCrAb Actions for chromatic 
aberration are counted as 8 ideas, 
not the 32 individual Actions. .  .  . 26

	 Bonus Actions and undocumented 
fun are included. 

http://www.digitalsecrets.net/ActionsCS5/

What’s on the DVD
	
The eBook file (you’re reading it.)
	 The ActionsCS5 folder
	 Adobe Reader for Windows
	 	 XP
	 	 Vista
	 Adobe Reader for Mac OS X
	 	 Snow Leopard, Lion
	 Extras Folder
	 	 Panoramic tutorial images
	 	 Demonstration/test images
	 	 iBannerImage folder
	 	 	 iBannerImage1.psd
	
Top Action Build Shortcuts 
	 Win / Mac
Dismiss an Action alert window: 
	 Return or Enter
Default Foreground/Background colors
	 D key
Change Foreground/Background colors:
	 X key
Close an open image without saving:
	 Ctrl+W / Command + W... + D 
Save the current file:
	 Ctrl+S / Command + S
Save for Web & Devices:
	 Shift + Alt + Ctrl + S /
	 Shift + Option + Command + S

Adobe Reader keystroke 
navigation shortcuts 

Click away from page objects in the 
right margin to fully activate the 
page’s response to key stroke 
instructions.

Zoom in / out of page:
	 Ctrl (Win) or Cmd (Mac) +/-
	 Plus or minus keys.
Reader remembers the order in which 

you have browsed pages.

Back or forward to the previously 
viewed page:

	 Ctrl / Cmd + Left or Right Arrow 
key. 

Up / down in page order:
	 Up or Down Arrow keys.
-or-	Left or Right Arrow keys.
	 Page Up or Page Down keys

NB: Adobe Reader works somewhat like 
a web browser page, in that it can 
step backwards through pages in the 
order you viewed them. 

	 Small arrow buttons in the header 
bar work this way.

	 Arrow keyboard keys alone step 
to and fro through pages in page 
order, not viewing order. 

	 Reader’s larger left/right arrow 
icons work this way.

iPad Viewing and navigation 
tips (iBook app)

Pinch in / out of page:
	 iPad viewing lets you zoom in 

and out of images or text with 
expanding two finger gestures 
(zoom in) or pinch gestures 
(zooming out). You may also 
double tap on any image to zoom it 
larger or smaller.

Tap navigation on open pages:
	 Single-tap in the middle of an open 

page to bring up the navigation 
header and footer. The footer 
lets you move a page selector 
horizontally.

View. In the header, next to the Library 
return button, a List View button 
lets you view pages as small, but 
very detailed reductions. Swipe 
up or down to navigate to nearby 
pages. Tap a reduced page to bring 
it up to full size. 

i The only negative feature of iPad 
viewing that we’ve experienced 
is its occasional slow rendering of 
large blow-ups. Nearly all images 
will zoom to maximum screen size 
when tapped.

 Meet the Actions / Navigation

http://www.digitalsecrets.net/ActionsCS5/
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INFOBITES
In the land of information, the bite is king. It cuts to the chase and calls a 

spade a shovel. 

Throughout this eBook you will see paragraphs that are marked with the 

InfoBite symbol, i. Always purple / always pithy, infobite paragraphs 

tell you of things that you really should know, if even just for a few 

moments. 

Often InfoBites are the why behind the wherefore, or explain the 

what behind the huh.

In most cases, they are the secrets that are better off being 

whispered into your ear by The Great Voice of Reason, the clues 

that keep you from being clueless and the icing on the cupcake 

of tasty data.

i You don’t have to memorize the InfoBites, but they might just 

contain a tidbit that will trigger a memory during some future photo 

shoot or editing session. Here’s one now:

i In some computer plus Adobe Reader combinations, if you click in the lower 

left corner of a page that contains an interactive image, Adobe Reader shows a 

transparent blue box the size of the page’s largest interactive image. We don’t 

know why. Fortunately that’s its only confounding feature. So far. (This artifact 

has never shown up on the iPad.)
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You don’t just open Photoshop and think you’ve done your job—the 
magic is in how you work it. There are a HUGE number of hand tools 
at your fingertips, and each will achieve wonders. All you have to do 
is use each tool in exactly the right way at exactly the right time in an 
involved process. Often by rote. Sound easy? Maybe not. Pretty soon 
you’ll start wishing for power tools.

Assuming you know the basics, 
 

how to open, re-name and save image files, how to 

apply a Photoshop filter, make a selection and add text over an image—you 

are ready for Actions.

An Action is a string of steps in Photoshop. A recipe. A macro. A program. 

A fixed cluster of do this, do that commands all neatly formatted so you can 

run it anytime on an open image. Patiently, the string of instructions will wrestle the 

myriad functions of Photoshop into achieving some repeatable process, manipulation 

or effect. The seagull above wasn’t shot with a cross star filter, but the prospect of 

adding it later was in my mind as I clicked the shot. The Actions in this eBook are 

already written. You merely load them into your Photoshop CS5, then click on them to 

run their instructions automatically.

The image above started as the image at left. No cross star filter there, but in the 

final shot an Action has supplied the twinkle rays that add the missing fantasy.

Actions / Reactions
Before you begin...

Chapter 0
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No Photoshop book is going to spend the time and effort to guide you through 

a process with 20, or let alone 100, distinct steps. Nor should it. Once you get 

past about six or eight discrete sequential manipulations, a foo-factor sets in: 

The Primate Limit. Assuming you also are an advanced monkey-brain as I am, 

our casual limit for remembering a new set of sequential steps in any operation 

is around three. Hence, “simple as 1, 2, 3!”

It’s not for nothing they didn’t say “simple as 1, 2, 3, 4, 5, 6, 7, 8, 9!” 

Humans don’t often have the ability to quickly absorb even five steps dropped 

on them out of the blue. But that’s what Photoshop steps in a process can feel 

like. Steps are often not intuitive, and much of the time, some may seem trivial, 

but when the final result can is seen, oops, every step was important.

So how do we get correct results? Do all the steps in precisely the right 

sequence. But, unless you had the list of exact instructions at your elbow, you 

could forget about accurately remembering all those steps. You primate, you.

As complexity rises, our ability to deal with it while making a subtle or drastic 

mistake grows nearly exponentially. A 20-step process stops being obvious, 

interesting or even fun. But for a computer, it’s a piece of cake, a snap, no biggie.

Our minds may—read: definitely will—wander. We may substitute a 4 for a 6 

in a critical numeric entry. We may leave out a step. Suddenly five or 10 minutes 

worth of mind-numbing effort ends in a visual train wreck. Oh, the humanity!

And how do we recover from errors like this? Photoshop’s History Panel gives 

us a list of recent operations we have made, so there is a quick way of tracing 

backwards by clicking on earlier steps. But will we actually recognize that the 

11th step in a 20-step process was the one that went haywire? 

Fortunately, the Actions Panel in Photoshop CS5 is one of its greatest tools, 

because it lets us memorize scores—hundreds, even—of exact Photoshop steps 

to produce a desired visual result again and again.

Quick, Memorize this list of activities:
•	 Blink three times
•	 Wet your lips
•	 Flare your nostrils
•	 Crook your finger
•	 Lift your gaze
•	 Purse your lips
•	 Wink your left eye only
•	 Say the word, “Sprocket”
•	 Smile slightly
•	 Look to the left
•	 Wink your right eye
•	 Clap your hands twice
•	 Sniff
•	 Slap your forehead once
•	 Clear your throat
•	 Look to the right
•	 Fake a hiccup
•	 Mutter, “Ooo!”
•	 Touch your nose with your still-crooked finger
•	 Spin around.

Each easy to do, but virtually impossible to remember by 
someone who isn’t a performance artist. And this is only 20 
easy body gestures. What if you had to make a sophisticated 
marionette accomplish all these steps? You’d probably get 
strung out.
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SEEING AND STORYTELLING
A photograph can be a story in a form analogous to speech. Every 

photographer is free to invent a new way of speaking through images. 

Photographs start with light, composition, framing, subject matter, 

gesture, life and color. Good photos are somewhat like a sentence. 

Subject, verb and modifiers are all represented. The verb idea is what 

your subject is doing. The modifiers are the elements like juxtaposition, 

perspective, color, environment, motion and tonality that enter into the 

communication. At the fundamental level, a photographic sentence might 

be, The Flower Exists, and that may be fine for evidence photography, but 

you usually wish to say more. 

The Flower Glows with Life, or The Flower is Covered With Dew, suggest 

an amplification of the image and tells a more interesting story by includ-

ing mood and/or environmental conditions.

When you get into the idea of mentally captioning your images as you 

take them, you will have transcended the obvious. As your photographic 

prowess expands, you will feel moments of storytelling coming together 

as you view, frame, compose and capture. 

Knowing that you have a range of options to complete your image later 

produces a mental feedback that expands your possibilities as you shoot.

THINKING IN ACTIONS
Included with this eBook are the over 700 iNovaFX Actions. Each 

expands the vocabulary of your photographic/storytelling options.

• Errors. Things like native barrel distortion, chromatic aberration and 

shots made at the wrong white balance can largely be eliminated from 

images with a key click. “The shot looks correct.”

Invent a story caption 
for each image. I’ll 
get you started. For 
the hydrant: “There’s 
one in every crowd.”
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Almost all images can be altered and 
improved. Some can be transformed into 
completely different representations of 
the original subject. The shot at left has 
been changed from a color scene into a 
pseudo-infrared monochrome image.

• Limitations. Aerial photos can have atmospheric haze removed. Low 

contrast images can be delicately improved by applying a localized contrast 

effect, which doesn’t alter exposure or brightness—just snap. Slightly miss-

focused shots can be sharpness-enhanced. Higher ISO sensitivities than 

those available in the camera may be implemented. Grain and color noise 

can sometimes be reduced in special ways that preserve detail. “In spite of 

unusual conditions, the shot looks like what my eyes saw.”

• Filters. Grad filters, cross star filters, color tint filters, color filtration for 

B&W exposures, infrared, polarizing filters and controllable diffusion filters 

may not need to be physically present on your lens to get the effect you 

wish. These software filters produce camera filter effects without the glass, 

reflections, flare or fingerprints. “We added some magic to the lens.”

• Conversions. Photographers have always sought to turn certain images 

into artwork, hand-crafted illustration and bold graphic results. Now digital 

techniques deliver on that promise in depth. Photos processed through 

certain Actions become oil paintings, watercolors, striking designs and delicate 

line drawings. “And you thought this was a simple photograph!”

• Amplification. Some images may feel ordinary at first, but with the right 

Action they can become—more. Bigger in their impact on your mind, stronger 

in their inherent story or more connected to 

your viewer’s attention span.

Since the eye of the beholder is in your head, 

you get to shape them so they reach their full 

potential. For some, these Actions are going to 

make all the difference. “Wholly cow!”
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ACTION ANATOMY
Actions* frequently duplicate layers, adding and combining opera-

tions into an orchestrated result. In most cases, the results are simpli-

fied into just a few layers or a new single layer image.

Some Actions change the whole image, producing a completely new 

image. Repairs to barrel distortion (iBC-series), for instance, pull the 

image back into straight-line linearity by tugging and pushing all of 

its pixels around until pinches and bulges are corrected.

Some cause tonality changes to global or local areas. When white 

balance or color correction is wrong (iCC-series), every pixel will be 

altered, but geometry, sharpness and exposure will remain the same.

Others retain the original image but add to it in various ways. Glass 

filter effects such as diffusion, halos, grads, cross star effects and 

vignettes usually keep the original untouched but superimpose layers 

over it to change the look of the shot.

Several series add frame effects to a picture. While the image is not 

changed, its presentation environment is. Now it becomes a sheet of 

film, a stamp or one of many diverse images on a single page.

Still others sharpen contours, reduce noise in areas of color 

and shading, alter tonalities or re-render the image into graphic 

interpretations.

You will have passed another milestone when you shoot your images 

knowing that a particular Action will likely complete the shot.
 

(NOTE: View this page in Adobe Reader if the list art
has acquired a negative look in your browser.) 

The Generic Action:

• RECORD MODE ON.

First: You do this.

Then: You do that.

Now: You do the 

other thi
ng.

Plus: Take a sna
pshot 

of what you did.

And: Change som
e-

thing major.

Next: Take anoth
er 

snap—what the h
eck, 

you might need 
it.

Also: Add a little
 bit 

here and 
there.

After that: Fudge it 

like so.
Furthermore: Tweak 

this and t
hat.

Then: Take a final 

snapshot
.

■ RECORD MODE OFF.

* “Actions” in this eBook, when capitalized, stand for the Photoshop Actions as opposed to simple physical 
actions or activities, such as waving your hand, thumbing your nose or clicking your mouse.
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PHOTOGRAPHY AS AN EFFECT
Photography of all kinds is its own sort 

of special effect. In your eye, it’s natural, 

but in a camera, it’s a huge assembly 

of esoteric technologies, scientific 

breakthroughs and oddball techniques 

that cause it to happen at all. 

Digital photography is such a desirable 

capability, and so pervasive, that nobody 

thinks of it as special any more. But out 

of Einstein’s initial understanding of the 

photoelectric effect, Galileo’s appreciation 

of optical craftsmanship, Smith and Boyle 

(Bell Labs, 1969) realization that image 

chips were possible, 

Bayer’s design of 

color separations from 

repeating patterns of 

color tiles—each of these 

being a wonder unto 

itself—digital photography 

has evolved into a mega 

wonder so commonplace 

that we rightfully take it for 

granted.

Is it a watercolor or elaborate pen and marker 
illustration? Of course it is neither. Two are from 
a series of interpretations. The image above this 
text is the original.
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AMPLIFY YOUR IMAGES
Most of your images will be straightfor-

ward representations of things the way they 

look to your eye. Snapshots of life’s events, 

pictures that remember who was where 

and when. Records of what stuff looked 

like under certain circumstances. These are 

photographic staples.

But some of your shots will beg to 

become more than what your eye saw. 

Artists play with images in ways they feel 

may add to their appeal. Communication is 

their art. Trying things in a variety of ways 

is common among painters, graphic artists, 

musicians, performers and achievers in 

every field. So it is with digital photography.

By applying various treatments, 

interpretations, alterations and adjustments 

to an image, you can add to its appeal, 

power and narrative.

Even the very first image ever captured 

and preserved for long term viewing is not 

immune from further treatment, amplifying 

its presence for illustrative value.

The world’s first snapshot; amplified. The snap, in this 
case, took eight hours in full daylight. © 1827 by Joseph 
Nicéphore Niépce. All rights reserved.

The above image isn’t Niépce’s. It has been processed 
with the iNovaFX iHalcyonWarm Action to make it look 
gratuitously “old.” © 2010 by Peter iNova. All rights once 
again reserved.

Niépce’s original is the smaller one at right.
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TESTING 1  2  3
In some production processes, testing one’s results for quality or 

effectiveness is a major part of the job. Actions provide a convenient 

way of testing images for expanded possibilities—because they are 

so effort-free. Actions that either preserve layers or save snapshots of 

intermediate steps may provide a basis for further manipulation. You 

might be only partly finished with a picture after applying just one 

Action.

COMBINING 1  2  3
When a single image is tested several ways with various iNovaFX 

Actions, the History Panel will load up with snapshots of variations 

and alternative treatments. 

Snapshots that appear with layers usually will allow copying a layer 

to the computer clipboard from one version, selecting a different 

variation, then pasting the copied layer onto it to produce new, 

combined results.

For example, the iHalo Action effect layer at middle right was deemed 

not quite enough. An added iCrosstar Action created a different effect 

layer result seen at the bottom. 

Are you thinking what I’m thinking? You 

could run both—halo, then cross star—then 

add both effects to the same shot by 

moving effect layers around. Since they’re 

layers, you have control over how they look.

Snapshots with several layers often retain a filtered 
effect as a separate layer (middle, bottom) riding 
above the original image. Be aware that you may 
have to flatten the image before saving it as a 
composite. If you run a different Action on the 
same original image, you may be able to add the 
effect layers together to achieve a result like the 
top image. 
Here’s a secret: Any light on a black background 
can be added over an image using the “Screen” 
blending mode. Screen behaves exactly like a 
double exposure.
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IN-REGISTER FX
It’s easy to select an Action’s effect layer, copy it and 

paste it on top of a different Snapshot, thus combin-

ing both effects.

i Usually, the effect layer is combined with the 

original image using a Blending Mode (Multiply, 

Darken, Screen, Overlay, etc.), which is displayed in 

a box in the upper left corner of the Actions Panel. 

i Alas, selecting and copying a layer doesn’t 

copy its Blending Mode, so when you paste it in a 

different image, you will have to change its Blending 

Mode to the desired state.

i Screen Blending Mode produces the exact same 

effect you would see from a double exposure. 

Think: two slide projections onto the same screen, 

one projecting the picture, the other projecting 

the effect. For effects like iCrosstar and iHaloCS5, Screen is the usual 

Blending Mode you will use, since those effects are made of light.

i With PS CS5, you can shoot images that are close to being in-

register and have Photoshop line them up for you later. Look for 

iNovaFX Actions called iStackCS5, iReRegister and iBlend[# of layers] 

in the iRegister folder.  (The hand-held image here used iBlend6 and 

is made from six images shot at the Getty Museum in Los Angeles.)

i The CS5 Action, iStackCS5 asks you to identify the shots as 

either ones currently Open, or all that are in a specific folder. If you 

check the Attempt to Automatically Align Source Images box, it will 

perform what iReRegister does, as well.

Museums are notorious for preventing tripod use. But some kinds of shots 
would be better if a tripod were employed. This series of images were 
gathered in Continuous mode, but hand-held minus a tripod. Photoshop’s 
Load Files into Stack and Auto-Align Layers features make setting up 
this stack into quick work. Now it’s a sort of time-lapse still image. Actions 
made this sort of assembly easy. The equal participation of all six images 
and its automatic registration were achieved with the Action called 
iFrameAvg-6Shot seen on page 223-224.
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Here’s a cross star effect overlaying the 
original image. Above the effect layer is an 
Adjustment Layer for Hue/Saturation. It is 
connected only to the layer, X, below it and 
does not affect the Background layer.
The inset shows what the natural color of the 
cross star effect looks like with the Adjustment 
Layer turned off.

LAYER EFFECTS
Many iNovaFX Actions take advantage of Adjustment 

Layers, which alter only the content layer immediately 

below them. Look for the tell-tale Adjustment Layer graph-

ics and a bent, downward turning arrow to the left of icons 

and matte windows.

The chief advantage to leaving a snapshot in this state is 

that further adjustment of layers is instantly available, later. 

It’s easy to flatten all layers into a composite, single layer 

image, then save it under a new name, but as long as an 

Adjustment Layer remains active, its current condition can 

be regarded as a recommendation rather than as 

a final decision. The existence of an Adjustment 

Layer means that editing to this point has been 

nondestructive (not yet resolved). 

In Photoshop CS5, Adjustment Layers can be 

live instances of Curves, Hue/Saturation, Levels, Solid 
Color, Gradient, Pattern, Color Balance, Brightness/Contrast, 
Exposure, Photo Filter (color), Selective Color, Channel Mixer, 
Vibrance, Gradient Map, Black & White, Invert, Threshold or 

Posterize. Previous Photoshop versions offer fewer options.

i If you do move a layer to a different snapshot, then select any other snapshot, 

the move will be lost. After adding anything to a snapshot, immediately make a new 

snapshot to preserve both the move and your ability to backup a step.

If you make an Adjustment 
Layer but forget to tie 
it exclusively to the next 
layer down, there’s a quick 
fix: Highlight the Adjustment 

Layer and press Control 
+ Alt + G (Windows) or 
Command + Option + G 
(Mac).
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ACTION BEHAVIORS
Two basic modes exist within Photoshop to select and imple-

ment Actions. They’re called List View and Button Mode.

Button Mode creates a window full of individual Actions by 

name, each in its own rectangular box that can be pressed 

(with a mouse click) like a button. 

If an Action includes an instruction that stops all continu-

ing operation—perhaps to accommodate input or manipu-

lations you make manually—the button becomes fierce 

red, indicating that it should not be ignored. Re-clicking 

the bright red button continues from where it left off.

i Neither mode is perfect. Button Mode feels overly 

simple, and List View can seem like too many details 

to absorb at a glance. List View allows you to edit and 

create Actions, so it’s worth studying.

When using List View, any stop in the stream—even just 

for a cautionary note—will open the usually collapsed 

list. Now you see all its instructions in a vertical column 

as in the top example here. The cautionary note can be a 

reminder, a heads-up concerning something that is about to require action from 

you or a note telling you of some special condition that now is in play.

STOP
Sometimes you will come to a full STOP, and Continue will not be an option. This can 

occur for a variety of reasons. The Action may have stopped so you can perform some 

activity that can only be done by hand, such as a painting or retouching operation. 

Top, Button Mode with the iBaby1V (one 
of several variations) identified, but when it 
is stopped mid-stream (bottom) the button 
becomes bright red. In use, a second click 
resumes carrying out operations until it 
pauses, stops again or finishes.

At right, List View showing that both the 
iComplexArt folder and the iGrad folder are 
open, and the individual Action, iGradAmber, 
is open, showing its list of instructions. At 
far right, the iCanvasPainting3 has been 
opened—one of the iComplexArtFX-series—
shoving everything farther below. Note that 
the seventh instruction, Curves is also open 
with a down-pointing arrow, showing its 
internal settings.

No wonder Button Mode seems so simple 
and List View seems so complex. But most 
of the time, List View is collapsed to a list of 
Action names, making it more accessible.
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Some Photoshop activities can’t be fully controlled by an Action and you must do something 

manually. We’ve tried to spot these and warn you about them in alert windows. Reducing an 

image so 100% of its pixels are seen is needed when a basic Paste command is issued. Paste 

attempts to drop a clipboard element smaller than a full frame into the dead center of the 

existing view. If that view is offset—as is often the case when it extends beyond the current 

frame—the pasted image won’t be perfectly centered and this might mess things up. In some 

few Actions, the incoming Pasted image MUST be centered. Where that’s needed, a Stop 

command plus an alert window will clue you into what’s needed.

i You can shrink an open image window to fit on your computer screen with a handy 

keyboard shortcut. For Windows, hold down the Control key and tap the minus (–) key. Each 

tap shrinks the image by about 33%. For Macintosh computers, the same idea uses the Com-

mand key with the minus key. Enlarging the image employs the plus key (+) in the same way.

i For all other keyboard shortcuts, we will write out the Key(s) that must be pressed, fol-

lowed by a plus sign, followed by the character key that activates the operation. Microsoft OS 

/ Mac OS commands will be written in that order.  Oddly, the unique command to enlarge the 

image window would look like this: Control + + / Command + +, which is slightly confusing.  

This one makes more sense: Shift + F, which steps through a loop of three different display 

formats, but you must press it three times to get back to your original floating image window.

RESTARTING
To move forward from a stopped place, close the alert window (when Continue is an 

option), automatically rejoining the next steps. Or if you have Stopped to do some more 

complex operation, click on the right facing Play arrow at the bottom of the Action 

Panel. It will continue with the next instruction, continuing until finished or another Stop 

is encountered.

With the Actions Panel in List View, 
the right-facing arrow in the bottom 
border is the RUN command.
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HOW AN ACTION WORKS
As an Action unfolds, it’s a sequence of steps in a unified process.  You could 

perform these actions manually.  While that is simple in principle, in many cases it is 

unreasonable to ask mere mortal human to apply even 10 discrete steps of manipula-

tion to an image to produce a single, seemingly minor adjustment to it. 

i Bear with us. We’ll show you what’s going on under the hood of an Action, 

then get to the juicy, automatic Actions in a few pages. If you just can’t wait, you 

can jump ahead by clicking on this link.

Here’s an example. The Goal here is to adjust a photographic image that has a 

noticeable degree of chromatic aberration, caused by a particular 

setting of zoom and focus. Photographers often refer to chromatic 

aberration by the acronym CA. Photoshop CS5 has a built-in feature 

that simplifies elimination of chromatic aberration,  but bear with us 

before you decide it’s all you’ll ever need. 

Lens designers try to avoid artifacts like this, but they are faced 

with multiple goals of radial sharpness, tangential sharpness, zoom 

magnification, barrel and pincushion distortion, dimensional linearity, 

flatness of field, evenness of light distribution and CA.  If they fail, the 

image may bulge, have astigmatism, be soft in its corners, vignette 

its light distribution or show small color fringes, especially in the 

extreme corners of the image.

CA appears when light of particular color is either focused behind 

or in front of the image plane while other colors arrive in a more 

coordinated manner. Alternatively, light of a particular narrow 

spectrum can form an image that is in focus but is a tiny percent 

larger or smaller than other colors. This last version is the most 

common, so let’s fix it with a series of manual tweaks.

Image corners reveal classic chromatic aberrations. The phenomenon (enlarged crop) appears as 
a color fringe around contrasty detail. Changing the size of an individual red, green or blue color 
channel can improve the view. The CA seen here is a combination of Red/Cyan and Magenta/
Green, producing a Red/Green result. Digital images are sharpest in their Green channel, so it’s 
prudent to only alter the scale of the Red and/or Blue channels.
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Theory of adjustment. We know that the green layer of an RGB image 

accounts for most of its perceived sharpness, so we use that layer 

as the standard to which other color layers will be compared. We see 

that a Red/Cyan fringe is showing up in the corners of our shot, so 

we will first size-adjust the Red channel of our shot, aligning it more 

in-register with the Green and Blue channels. 

1. First we select only the Red channel.  (Windows: Control + 1 / Mac: 

Command + 1) Now we see a black and white image of the Red chan-

nel by itself.  If Photoshop’s Preferences > Interface has been instructed 

to Show Channels in Color, then the image is a red and black image. 

Intuitive, but more difficult to see in detail.

Operational caveat. Re sizing the individual channel can only happen if 

that channel can be scaled larger or smaller about its optical center.  Its 

optical center is only intact in an original file that hasn’t been cropped.

2. We select the whole Red channel image with a Select All command 

(Control + A / Command + A). Selection’s marching ants surround the 

Red channel image at its farthest edges.

3. To scale the image, we will change its size with the Transform feature 

(Control + T / Command + T).

Photoshop Tool Behavior requirement. Selecting an image is one 

thing, but we must make sure that any change originates in its center. 

In the upper left corner of the Transform 

tool header is an icon called the Reference 

Point Locator that causes transformations to 

operate from any corner, from the middle of 

any side, or from the center of the image. If it 

isn’t already selected, click the center box.

The optical center of the full frame, above, is 
the same point from which chromatic aberration 
phenomena radiate (middle). When the image is 
cropped and leveled, the optical center (yellow) 
stays with the image’s pixels, but any attempt 
to repair chromatic aberration will be tied to the 
center of the remaining cropped image (bottom). 
The moral to the story: Only repair chromatic 
aberrations with full, original frames.
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4. We want the scaling to be linked in both vertical and horizontal direc-

tions, so we look for the W and H (Width and Height) boxes.  Between them 

is a link. Click the link.  Now they are tied.

Experience notation. Photoshop’s scaling via numeric entries is only 0.1% 

accurate. Image size adjustments don’t change with two decimal places of 

precision.

5. We guess that the amount of needed change to the Red channel is about 

99.9%, so we enter that amount in either of the W or H boxes and hit return. 

Our image twitches slightly.  The Red channel has become 99.9% of its 

previous horizontal and vertical dimensions.

6. Dismiss the Transform tool (Control + Return / Command + Return), so 

we can view our result.

7. View the full color image by pressing the tilde (~) key, or use Control + 

~ / Command + ~. The slightly smaller Red channel has a cyan border a few 

pixels wide surrounding the image.

Whoops, it isn’t quite perfect.  Some residual CA still colors the shot. 

8-15. Go back to the original image and try steps 1-7 it again, but this time, 

put in a value of 99.7% and see if you like it better.

Drat.  Too much correction. Now the CA is inverted with colors on the 

opposite side of small details. 

16-23. Go back to the beginning and try 99.8%. 

That’s much better (at least for our example image it was). But there is still 

just one more thing. 

Final tweak. The Red channel has shrunk, leaving the Green and Blue chan-

nels at full size.  A thin cyan border one or two pixels wide surrounds the 

color image. 

At 99.9% scale, the CA still shows (top). The middle image 
shows what we see at 99.7% scale. The fringe is now on the 
other side of details. At bottom, we see 99.8% scale. This is 
about as close to correct as we can produce numerically.
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25. Interestingly, the Red Channel is still selected, even 

when the RGB image is showing, so clicking on Image > Crop 

will trim to it exactly.  The picture will have lost a few pixels in 

dimension, but nobody will ever notice that. What’s far more 

important is that you will know you’ve done your best to lift 

your image above the limitations of DSLR technologies.

26. Save that picture with a new name to a convenient 

place in your photo library.

It was simple; it was easy. Somewhere between 10 and 26 

steps later you will have improved any red fringing from chro-

matic aberration that showed up in the corners of your image. 

By now you will be wishing for some sort of power tool to do all 

this grunt-work for you. Until PS CS4 showed up,  that’s where 

Actions came in.

Conceivably, you could record an Action that followed 

all nine image tweaking and cropping steps, thus saving 

yourself all that work for every shot made with this lens 

at this zoom setting.

We have gone one step farther. An Action set called iCrAb, which contains a bunch of 

individual Actions for reducing chromatic aberrations. 

Near the top of the list is iCrAbRedShrinkMaster.  It is to be used ONLY with an 

original image, not a crop, and it automatically performs every Red channel size 

reduction possible from 99.9% to 99.1% in 0.1% decrements, leaving each variation as 

an individual snapshot in the History Panel, so you can click on them and find the one 

that seems to do the job best with the current image.

There are also iCrAbRedExpandMaster, iCrAbBlueShrinkMaster and iCrAbBlueEx-

pandMaster Actions as well, each doing reductions or enlargements of individual color 

channels by 0.1% changes, leaving snapshots in their wakes.

The final image with all its complex detail is far freer of 
chromatic aberration and this is very detectable in prints 
larger than 4 x 6. But the real story here is not how well 
you fixed the picture, it’s all about how much work you 
went through by scaling individual color channels to get 
there.

The Actions set, iCrAb (Chromatic Aberration), may be 
used with Photoshop versions clear back to PS7.

Photoshop CS5 has Lens Correction settings that 
eliminate the need to use this manual process or the iCrAb 
Actions. Though tempting, these may not be as precise as 
you may wish.
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i You may need to alter Red and Blue to achieve a more perfect result. Often it is not techni-

cally possible to completely reduce CA to zero, but usually you can reduce it significantly.

i To move both Red and Blue, run Red first, since its effect is easier to spot. Select the 

Snapshot that seems to reduce its effect the best, then use that for your new starting place 

as you apply a Blue correction.

Other iCrAb Actions in the set (iRedShrink1, 2, 3 ...7, etc.) work through different principles, 

so you may wish to try them on problem images.

i All of the iCrAb Actions work with all sizes and orientations of image, but must be used on 

original camera files before other alterations or Actions modify the shot.

HISTORICAL NOTE:
i This process of expanding or shrinking individual color channels was first embodied in the 

original iCrAb Photoshop Actions that appeared in the year 2000 and were distributed with our 

first digital photography eBook back then. Copies were purchased by people at Adobe, Nikon, 

Canon and other software producers. Around 2005, Adobe and others acted on the idea that 

size control of RGB channels held the key to chromatic aberration repair. Adobe’s latest embodi-

ment of CA repair appears in CS5’s Filter > Lens Correction > Chromatic Aberration and neither the Auto 

Correction (which uses a numerical look-up database for each camera body/lens combination) or 

Custom (Manual) options appear to be as accurate and aberration-free as our own iCrAb series. 

For speed, use the CS5 version. For the greatest precision, use the iCrAb versions.

Within iCrAb’s folder of 
Actions lie four Master 
expand and shrink Actions 
that create every up or 
down scale variation 
within Photoshop’s 0.1% 
range of scale changing. 
The other Actions in this 
series use a different 
method of scaling and are 
a bit more precise, but 
slower to execute.

Original with CA / Photoshop CS5 auto correction 
repair (linked to lens database) / iCrAb two-
pass version. This is the upper left corner of an 
8-megapixel original. Fine details show that the PS 
CS5 automatic option didn’t improve it much, but 
running the iCrAbRedShrinkMaster followed by the 
iCrAbBlueShrinkMaster (after selecting the Red 99.8% 
snapshot) produced the image on the right. iCrAb in 
CS5 runs extremely quickly and not only produces a 
superior result, but takes very little extra time. Original                                                                             CS5 Auto                                                                          iCrAb 2 pass
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POP CA QUIZ:
Find an image in your collection that shows corner chromatic aberration somewhat 

like the iCrAbVatican.jpg image on this CD to practice the steps that reduce this 

aberration.  That practice shot is in the folder called Example Images. 

But before you do, close this eBook and no peeking. It’s not hard. It’s only a 

10-step, easy-as-pie fix with each step logically leading to the next.

If you are like most people, you will gravitate to the power tool of an Action or 

other chromatic aberration reducing utility the next time you need to adjust an 

image this way.

And that goes for almost any image correction, enhancement or transformation 

that you will wish to apply frequently. In the coming pages you will learn how to 

make Actions, how to modify them and how to use the hundreds of iNovaFX Photo-

shop Actions as power tools for your digital darkroom. 

i Photoshop CS2 - CS5 have a new feature not seen in previous versions. It’s found 

under Filter > Distort > Lens Correction and provides some basic Barrel / Pincushion distor-

tion, Chromatic Aberration, Vignette, Perspective transformation and tilt correction 

accompanied by a convenient grid overlay. Our thirty-second review of this feature 

is seven on a scale of ten. Its CA and Vignette corrections are well implemented and 

interactive, while its Barrel distortion and Perspective correction features are less 

accurate or less convenient than using other means within Photoshop to achieve the 

desired results. The best implementation of this feature appeared in PS CS4.

i Photoshop CS5 moved this function to a more directly accessible place right 

under the Filter menu item, added a Green/Magenta Fringe manual correction 

slider to The Red/Cyan and Yellow/Blue versions and changed the emphasis of the 

numerical readouts associated with each adjustment. We wanted this feature to 

be wonderful, but it doesn’t improve much on the previous version and the Auto 

Correction option is not as precise as we had hoped.

Pop Quiz
No Peeking

No Turning Pages
No Crib Notes
No Cheating

No Asking Your Neighbor
No Using the CA Actions

You must do all the steps
from memory, applying the
principles of CA reduction
using Photoshop's tools 

alone.

Begin.
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Clearly the problem with a small fix like this is that you might have to try a number 

of different values to find the one that best matches the problem. And each time you 

did the test, you would have to do all of the steps perfectly, or your results would be 

untrustworthy. 

So our iCrAb(color)(shrink/expand)Master Photoshop Actions do the grunt work for 

you. They perform a series of color channel scale reductions and leaves a string of 

Snapshots in the History Panel for you to choose from. They work with any size image, 

horizontal or vertical. Click on any snapshot to see how much better it has adjusted 

any single color fringe, then run the other color of Shrink or Expand on your first 

result, then look for a snapshot that is even more refined. The green channel is not 

touched, nor should it be, since the green channel of an RGB image contains the most 

accurate record of detail (59%). 

i By appropriately adjusting the Red and/or Blue channels, all variations of color 

fringing may be repaired. Magenta/Green fringes are due to both Red and Blue being 

together in their degree of offset. Yellow/Blue fringes result from Blue channel offset 

alone, and Red/Cyan fringes are the result of only the Red channel being offset.

HISTORY PANEL VIEWING
It is common to have the History Panel open and accessible when using Photoshop. 

If it isn’t open right now, you can make it visible by selecting Window > History in the 

header bar. Most iNovaFX Photoshop Actions generate a new Snapshot when they 

finish working, and it joins others at the top of the History Panel. 

Sometimes it’s simply called Snapshot 1, 2, 3... or it has been custom labeled with 

the Action’s name and shorthand notes such as “xxxLayers” or “Blue 99.5%.”



  30 | CHAPTER 0       ACTIONS CS5

i The iCrAbRedShrinkMaster series creates Snapshot titles like this: 

			   Red 99.9% 

			   Red 99.8% 

			   Red 99.7% 

			   Red 99.6%... 

It doesn’t take much code-breaking effort to tell at a glance what 

the critical magnification factor is, what sort of operation has been 

performed, and which color channel was involved.

In some Actions we have renamed the original file before running an 

operation, for technical reasons. Often it becomes Original so subse-

quent steps can identify it.  

i In the iCrAb...Master series, you end up with ten images in the His-

tory Panel. Your original, intact with its original name or file number, 

plus the nine incremental variations in 0.1% steps. You won’t see many 

images with more than 0.5% chromatic aberrations, but the other, 

higher values are there for emergencies. 

i When you zoom into a snapshot, then select a different snapshot, 

the zoomed-in scale and framing are retained, so you can inspect and 

compare enlarged areas sensibly.

i You can step forward or backward through multiple snapshots with 

these keyboard shortcut strokes:

Windows forward: Control + Shift + Z

Windows backward: Control + Alt + Z

Macintosh forward: Command + Shift + Z

Macintosh backward: Command + Option + Z
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INSTALLING ACTIONS
Photoshop Actions load into the window called the Actions Panel, which can be 

made visible through the Window > Actions command in the Menu bar.

By default, this window will open on the right side of the screen and can be 

sized small or large to your taste. Grabbing its tab and dragging that to another 

Panel will make Actions one of several tabs in that group, only one of which can 

be seen fully at one time. 

The current Photoshop is Photoshop CS5, in its twelfth generation, and many of its 

features are updated, enhanced and improved from CS4 and earlier versions. 

A case in point is the Edit > Automation > Photomerge feature in CS5, which stitches 

overlapping panels of a panoramic image into a corrected single larger image.  Prior 

versions of Photomerge were not nearly as precise.

i The shot here is a three-segment example that used the Photomerge Cylindrical 

option. A special iNovaFX Action in a folder called iPanoCylinderEdge > iPMCylinderEdge3 

(different Actions are numbered matching the number of panoramic elements) pro-

vides a bonus that Photoshop alone won’t give you: The clean round edges seen here 

are very different from the rough, stepped edges Photomerge intrinsically produces.

What’s with this panoramic image? It’s an elaborate sculptural musical instrument 
installation at the Getty Museum in Los Angeles. The people are waiting for it to play. 
Sadly, the magic was that it issued notes and sound at all, not that it sounded good. 
But I digress. The smoothly curved edge of the stitched panoramic image is the 
result of iPMCylinderEdge3 which works on panoramics you’ve assembled using the 
superior Photomerge feature of CS5 with three original images. Without the Action, 
the edges would be stepped, not smooth.

Actions load into 
the Actions Panel, a 
window that you can 
show or hide within 
Photoshop. List 
view allows you to 
see them enclosed 
within folders. The 
side arrows twirl to 
reveal individual 
Actions. Twirling 
an Action’s arrow 
reveals its internal 
steps.
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ACTION REACTIONS
Every Photoshop Action causes its own reaction. For some, like the 

correction of a mistake, aberration or flaw, the viewer never knows a 

correction has been applied.  Had no fix been made, perhaps a nega-

tive reaction would have occurred.

For others, like the conversion of a photograph into a watercolor 

painting, the reaction from viewers can be strong and positive.  Much 

of the impact of an image depends on how well its visual treatment 

mates with its subject matter and technical attributes. 

One rule dominates: Select the Action to produce the viewer 

reaction you wish to bring forth.

i Sometimes you will have to predict how an Action may 

complete the image as you shoot.  For instance, the iPolarizeSky 

Actions work best with strong blue skies since they trigger most 

cleanly off of clear blue pixels.

CORRECTIVE ACTIONS
Flaws from optics, camera settings and pilot errors made 

while shooting are sometimes correctable.  Truly awful color balance 

isn’t always fixable, but often it can be steered into a decent looking 

version of reality.  Most lens distortions can be tweaked into a non-

distorted state by manipulating image geometry selectively.

Sometimes nature hands you a photographic problem with excessive 

haze or natural atmospheric phenomena.  Aerial views look washed 

out, but can be largely repaired with the right Action.
A real photographer would never make the mistake of shooting 
outdoors with the camera set to incandescent white balance. But if I 
ever do, there’s always the iCCDaylight/IncanWB Action.



|   33Preface    ACTIONS CS5

OPTICAL FILTER ACTIONS
Optical filters require you to decide to use them before taking the 

picture. They embody the Law Of The Haircut. Un-cutting is impossible. 

Many iNovaFX Actions let you make these sorts of decisions on your 

computer where you have much more control.

Gradation filters, cross star effects, selective focus, refined exposure, 

diffusion filters, halo effect filters, polarizing filters and color filters 

for black and white photography previously were decisions you could 

never make later when things were quieter and more contemplative.

GRAD FILTER ACTIONS
Cinematographers frequently use grad filters to control the extreme 

contrast between sky and foreground subjects. Imaging systems like 

digital cameras often can’t catch the scene the way our eyes do. Not so 

surprising, considering that our eyes—once brightness adapted to the 

local lighting—operate over a tonal range of about 30,000:1. Film, video 

and digital photography are usually working with less than a 2,000:1 ratio 

between blackest black and bleached-out highlight white. RAW images 

provide a superior tonality range for interpretation in the digital dark-

room, but they’re something you must plan for. For JPEG images, you 

may have to resort to a grad filter to supply some missing sky dynamics.

Usually grad filters are clear on one half and dark or colored on the 

other half, blending gradually (grad; get it?) from one state to the other.

Action intervention. No polarizer 
was used to deepen the clear blue 
sky, above, and the sky behind the 
rider was bleached to maximum 
white. 



  34 | CHAPTER 0       ACTIONS CS5

FRAMING ACTIONS
Border treatments can complete an image by adding a graphic 

treatment to expand the context of the image. While numerous 

border treatment programs exist to provide this function, we 

have concentrated our efforts in making borders that look 

like the native frames caused by certain film photographic 

processes. Roll film, sheet film and 35mm frames are here. 

Additionally, stamp borders with a graphic perforation allow 

you to make images that appear to be stamps enlarged dra-

matically.

MULTIPLE IMAGES ON A PAGE
With more than one image per page, collections of images 

that complete a theme, sequence or story can be tied together. 

Actions to assemble these in groups of four and 16 are 

included.

Assembling images is an advanced 
form of storytelling. Placing an image 
in the context of a film frame suggests 
to viewers that the image is free of 
manipulation. Like a novel advertised 
as “Based on a true story.”
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VISUAL EFFECTS ACTIONS
The digital darkroom offers more control and a greater range of basic 

image alteration and manipulation opportunities than anything previ-

ous. Skies can be completely replaced, lighting apparently altered, and 

Photoshop’s own plug-in special effects filters can be used in alternate 

ways to achieve a wide range of new image treatments.

PHOTOSHOP FX ACTIONS
Photoshop has “Filters” that produce dedicated effects, most with 

special controls with names including

• Stroke Width • Paper Brightness • Edge Simplicity
• Brush Size • Glow Brightness • Stroke Detail
• Definition • Scaling • Edge Thickness
• Relief • Direction Balance • Spray Radius
• Fiber Length • Cell Size • Grout Width
...and many more. 

Memorizing the implications of all of these will take you months. 

Some of our iPS-series of Actions provide alternative starting places 

for photographic image manipulations using these effect tools. Others 

add some steps to get a better result from the primary Photoshop 

Filter, and still others combine several PS Filters into a logical variation.Photoshop’s own “Filters” can often seem difficult 
to wrestle. Our variations use them to deliver more 
interesting results quickly.
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PRINT PREPARATION ACTIONS 
Wet darkrooms had special chemicals and handling procedures that 

produced numerous printing options. These Actions emulate and 

expand on those techniques.

You can create printer-ready duotones, tints, sepia effects, aging 

effects, contrast enhancements and color tweaks that are more 

effective in printing than in viewing on the computer screen or Web.

We recommend that you shoot in color, even if 
monochrome will become the final result. Above, a 
distressed Sepia aged print effect, at right an Action has 
brought out an inner glow. Below, one image as if seen 
through B&W filters in green, blue, red, orange and yellow.
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GRAPHIC PHOTO FANTASIES
The eye’s the limit. Anything you can visualize adding to an image 

can be achieved, if you have enough time and money. Or the complete 

set of iNovaFX Photoshop Actions.

There is no rule that states you can only apply one idea to an image. Within iNovaFX 
Actions several ideas are usually at work. Sometimes you will wish to add some of the 
ideas as you shoot, and some of them later in the digital darkroom. At left, a panoramic 
was shot in three segments and later turned into a stylized graphic with iSumi-E. Below, 
two shots made within moments of each other have been turned into wild graphics with 
iBubble Actions. Intentional camera motion produced the streaks.
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ACTION PACKING
Actions are a box. They produce the same result over and 

over. But that doesn’t mean you aren’t free to think outside the 

Action.

Tweaks you make to the image—before or after an Action 

runs—can drastically change the result. Sometimes the lens only 

makes the initial sketch. You have to add the rest of the picture 

by hand, by computer, and by experience.

Running an Action is not the end of the process. It can 

be—as with the top image—just one step in a tangled path. 

Here, a fisheye image wasn’t a full frame circle, so a circular 

mask was artificially introduced to force the idea. Extra 

black margin was added to serve as a matte frame. 

Areas of extra sky and foreground sidewalk were retouched to 

extend the original image into the full circle. The iLiner3A Action 

provided the unexpected cartoon-graphic interpretation of the 

manipulated, cropped, retouched, bordered fisheye point of view.

The bottom image was easier. It used the same Action, but was 

shot with a full-circle fisheye adapter1 over the lens.

1	 Nikon (not Nikkor) FC-E9 mounted on several step-down rings onto a zoom lens. 
This optic is currently very hard to find. Originally it sold for about $250 US.
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Of all the mighty features in Photoshop, the ability 
to write and recycle sequences of steps as Actions is 
up at the top of the list for power, usefulness, and 
accomplishment, but many Photoshop users don’t use the 
Actions Panel very much. It’s almost a Big Hidden Secret. 

S ecrets are only mysterious when they are kept. I’ll let you in on 

the Big Secret: Actions often seem more complicated at first 

than they really are. In this chapter you will build two different 

Photoshop Actions—one relatively simple, and one relatively complex—

and save them, so any time you wish to accomplish their results for a 

new picture, all you will have to do is look them up and click.

The image on this page is emblematic of a condition that you may or 

may not have noticed. The zoom lenses that make digital photography 

such a pleasure contain a fatal flaw: Barrel distortion.

i Bear With Us, Part II. Chapter 1 shows you how to make Actions. 

But if you just want to get to using them, jump to Chapter 2.

Action Creation
Making simple and complex Actions yourself

Chapter 1

Most people might not notice the flaw in this image, but the architect 
would. The straight lines of the building, at the edges of the shot, 
are not really straight. Straight yellow lines superimposed over 
selected straight features reveal the geometric flaws. Especially the 
line at the top of the window. You will soon learn how to fix this.
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While you will likely never perceive distortion in images of people, flowers, 

skies or sports activities, any time a straight line cuts across your image, 

such as a horizon, building or flag pole, you will see a slight curve distort-

ing the subject. A prime lens won’t show this effect unless it is a fisheye 

lens which shows the phenomenon on purpose.

BARREL DISTORTION REDUCTION
Zoom lenses produce geometric distortions that change as the zoom 

lens moves from wide to telephoto. Typically, barrel distortion at wide 

zoom positions and pincushion distortion at tele positions. 

Barrel distortion bulges the image out from center and pincushion 

distortion pinches it inward. Lens designers try to minimize this as much 

as possible, but inevitably they must compromise the prescription and 

accept some balance of distortion at the extremes of the zoom range.

We are going to create an Action that rectifies linearity for a particular lens 

at a particular zoom setting. Before we begin to record the Action, open 

Images-Demos > ActionsExtras > Example Images > BarrelAction.jpg. 

We use this image because it shows architectural, straight-line detail. 

As you write an Action, you want an example image that will show 

unambiguous results when you get 

the numbers and operations in your 

Action correct. Once the de-barrel 

Action is right, you can use it with 

any image from that lens and zoom 

setting, knowing that straight lines 

will be preserved.

Not every image shows its barrel distortion as much as this. Look at the top line of the 
windows. Below are two additional images made with the same lens at the same zoom 
position. Neither cries out for barrel correction.
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You knew it was pixels when you shot it, but now it’s time to have a 
little fun. Convert your digital image into a sheet, frame or chip of film 
and print the whole image for instant chemical-cred.

F ilm is so then while digital is so now. But when your 

image needs a touch of then, digital can supply it now. 

This group of iNovaFX Photoshop Actions are com-

plex—far too many operations to list out on a page and expect a user 

to follow—but they reward the photographer by framing the image 

with the appearance of realistic traditional film borders.

We have all seen photographs printed along with the border effects of 

various film formats. It’s usually a message from the photographer to 

his buddies. The photographer is saying, “Look how perfectly I framed 

this shot. Right in the camera, I got it just right, and obviously nothing 

has been tweaked after the shutter click. See that film border? Notice 

how the composition is amazingly well coordinated to the limits of the 

available film area? Oo, I’m hot!”

Now you can be that hot. Or even hotter since you have managed to 

spoof the eye of the observer by pushing your pixels into a film frame. 

Oo, la, la!

Border Crossings
Where film and digital converge

Chapter 2
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THAT’S ALL FAUX
Three iNovaFX film border series are available to you, one series for roll film 

borders, one for sheet film—similar to 4x5 view camera frames, and one for 35mm 

film chips and strips.

They all include potential marginal titles and notations identifying them as digital 

images by default, but you will be able to customize this text with any memorable 

or pithy commentary you wish.

ROLL FILM BORDERS
In the heyday of medium format film, one of the standards dating to 1901 was 

roll film with opaque backing paper called simply “120.” The paper backing was 

printed with marks that could be viewed through a window on the back of the 

camera to line up fresh film for the next shot.

Most film was sold in 12-exposure rolls, although 24 exposure rolls eventually 

appeared for light-tight film holders. Cameras like Hasselblad, Bronica and Rollei-

flex shoot the 6x6 format of square frames (2¼ by 2¼ inches of film) of which the 

image actually covers about 56 x 56mm, and other cameras shot different format 

images on the same stock. 

These formats had names like 6x7, 6x9 or 2¼ x 3¼.

i A similar format, 620, had identical film and paper backing materials on a 

slightly thinner spool.

i The margin outside the image had pre-exposed factory markings embedded 

in it. Most viewers ignore it, but we let you type in anything for the more 

observant beholder. Like the real deal, our text color and brightness is 

purposely kept low to avoid distraction.
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Since day one, Photoshop has had a sturdy complement of “filters” as 
a major feature. When you open them for the first time, they have 
default settings that greet you. We have regarded them with a more 
photographic eye and have come up with new, improved default settings 
and expanded steps that deliver tastier images.

At first look, the Photoshop set of Filters seems capable 

of anything. They have categories like Artistic, Blur, 

Brush Strokes, Distort, and so on—14 in all. Within each 

is between two and 15 different filters for a grand total of 107 unique 

items. The list has been growing slowly with every new version of Pho-

toshop. Version 6.0 had 101 distinct items, all of which are included in 

Version CS5, so these are solid, continuing features of Photoshop in a 

broad sense.

They have hundreds of adjustments. Each one may have three or 

more sliders, settings, options or choices with names that are unique 

to the current filter. Getting used to them takes time. But once you 

understand a filter, it will be your friend forever.

Photoshop™ Filters, Plus, Plus, Plus
New life for the old standbys

Chapter 3
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iNovaFX iPS-series Photoshop Filters are collections of 

settings we favor commonly with the Photoshop Filter 

sets. Here are new starting places for you to use on 

photographic images—places that we think will give you a 

better, more graphic image treatment right away.

Most of them go beyond this simple premise. Extra steps 

are added that complete the general idea of the Photoshop 

Filter. You will find 98 individual treatments here, many of 

them bringing your image into a new light.

We employ Photoshop’s own designations to group 

them into eight categories found in the current version of 

Photoshop CS5, and we recommend that you set aside an 

afternoon or three to play with them on your images. The 

categories are:

iPSArtistic	 21 Actions

iPSBrushStrokes	 10 Actions

iPSDistort	 23 Actions

iPSPixilate	 6 Actions

iPS+Noise	 2 Actions

iPSSketch	 29 Actions

iPSStylize	 15 Actions

iPSTexture	 9 Actions
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Covering the lens with glass to produce a desired effect is nearly as old 
as photography. Here are filters that can’t be chipped and won’t take 
fingerprints. But it’s a trade-off. They won’t protect your lens, either.

F ilters protect and serve. But once you have protected your 

lens with a Clear, UV, or Daylight filter, adding another effect 

filter becomes a management chore: Take off the protec-

tor, then add the effector. Total time: way longer than it takes an 

emu to e-move. What if you could have many of those filter effects 

instantly—later?

This section deals with several types of filtration phenomena that can be 

achieved digitally, rather than optically. They can produce results similar 

to—but not exactly the same as—optical, polarizing, or even holographic 

filters.

iFiltersX
As Photoshop has evolved, so have the number of interesting things you 

can do with its features. The halo filter seen here can only be achieved in 

PS CS2 or higher. But until the Action that produced it appeared, its effect 

was not easily available at all, unless you used a very expensive piece 

of glass and committed to the effect during exposure. What follows are 

iNovaFX Actions that take the place of glass—and beyond.

Camera Filter Fantasticks
Glasstronomic Delicacies

Chapter 4

Night images that include spectral highlights can trigger certain effect filters. 
Here is one that produces circular halos around each fixture suggesting dynamic 
movement. This is the iHalo2X Action.
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Like any complex technology, digital image errors can crop up from 
numerous sources. Film had its own special set of errors, but not much 
could be done with them in that world. Now we can fix more things 
than we can shake a digital stick at.

ho among us has never made a big whopping 

image error—show of hands? I didn’t think so. 

When we shoot fast, shoot under pressure, 

shoot after a few days without that camera in our hands, our 

humanity sets in, and there can be only one outcome for that: we 

forget to (fill in the blank), so we shoot a less than stellar picture. 

Sometimes it can’t be helped: 

•The zoom lens has barrel distortion at wide angle, and only a 

few cameras have settings to fix it. Yours doesn’t.

•You’re shooting at 20,000 feet and no camera adjustment will 

see the ground the way your eye sees it. The camera sees haze. 

•You walk outdoors and leave the white balance back in the 

living room/studio/office, sunlight turns out cyan-blue images 

instead of the colors our eyes were certain they witnessed. 

If only we could fill in those blanks, later. 

With the right repair Action, the correction is often just a mouse 

click away.

Corrective Measures
Fixing images on the fly

Chapter 5

W
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GEOMETRY REPAIRS
Typical zoom lenses have 7 to 24 elements. The ability to twist a ring 

and cover all the focal lengths from widest to most telephoto is such a 

useful quality that attributes like image distortion take a bit of a back 

seat. Current DSLR lens designs have as much as 14:1 zoom ratios, 

making these a good choice for photographers on the go who don’t 

want to swap lenses frequently. Wide range requires many elements to 

keep focus and aberrations under control. Zoom range. Image quality. 

Number of elements. Cost. 

It’s a juggle out there.

When the image comes back distorted, due to an intrinsic compro-

mise in lens design, it’s time to hug your computer. Barrel distor-

tion and its complement, pincushion distortion, are things you can 

correct with Photoshop. Look for the Filters > Distort > Lens Correction tool 

in PS CS2 through CS5. It does a pretty good job of flattening barrel 

and pincushion distortion.

If you are using an earlier version of Photoshop, then the Lens 

Correction tool is not available, but the iNovaFX iBC Actions 

may help.

i As noted earlier, you can adjust barrel and pincushion distortion 

yourself in a few steps, but doing these numerous steps for every 

image you wish to fix is an activity that gets old, fast.

i As with the CA filters, Photoshop is your best tool when you are 

working quickly. When you wish to achieve exacting results, you 

may find the iNovaFX Actions more precise.
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Most DSLRs use an image chip that is smaller than a full frame of 

35mm film. A film format called APS-C made images approximately 

the size of movie frames, and many DSLR image chips are referred 

to as being “APS-C size,” but it’s only a rough scale reference.

At their largest, 35mm movie frames are 3:4 aspect and half the 

size of 35mm still frames. In DSLR photography, this means that all 

the image qualities you see in a theatrical movie can be achieved by 

your DSLR. Depth of field and angle of view per mm, especially.

Nikon calls their small DSLR sensors, DX format and their full 

frame format is called FX format. DX sensors have about 367 mm2 

of surface area. 35mm full frames (36 x 24 mm) have 864.

Canon refers to their smaller DSLR sensors as APS-C Size with an 

area of about 330 mm2. Full frame DSLRs are simply referred to as 

being Full-Frame.

Cameras with 4/3 (four thirds) format imagers contain a chip 

in 4:3 aspect with a 17.3 x 13 mm sensor covering a 225 mm2 

area. Close enough to APS-C or movie frames to share almost the 

same DOF and optical behavior characteristics.

All of the zoom lenses we have seen for any of these formats 

exhibit some degree of barrel or pincushion distortion. Barrel 

distortion appears at wide angle, and pincushion effects show 

at the longest focal lengths. Some lenses show nearly zero 

distortion at one extreme or the other, and most that show 

distortion have a middle zoom setting that is distortion-free.

i Once you find it, you could use this setting for distortion-free 

copying.
35mm movie frame (Super 35 at 24.8 x 18.7mm). 
Images are to scale.



|   195Artistic Conversions   ACTIONS!

Canvas / print. Oil paint / photons. Vision plus hand-eye coordination / 
lens and shutter. On one side, the tools of traditional art / on the other, 
the tools of photography. People used to debate if photography qualified 
as art. Now no art museum would be without it.  
It is, however, perhaps the most flexible of the graphic arts.

A rt is in the eye of... hey, it’s you! 
The beholder has found its source. When you make a pic-

ture with photons, it tries to portray the light and tonalities 

before the camera. After all, the major convenience of photography is 

that when the shutter has been pressed, your work is done.

Maybe not. Perhaps you wish to take your image farther. A lot 

farther. Perhaps that shot will best be appreciated as a painting, 

drawing, technique-rich graphic or cartoon. Some images deserve 

a life beyond photography as an illustration or iconic picture above 

and beyond the call of photons.

Here is a collection of iNovaFX Actions that convert photons 

into photo illustrations, generating a new presentation and 

appreciation of the subject.

i Close, magnified viewing of these helps in their appreciation.

Artistic Conversions
Painting with Light

Chapter 6

iGraphic3.

NB: The framing treatments in this chapter are not part of the Actions.
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iLiners
Many graphic styles marry color shading with lines that define the 

subject. The Hayes Island Effect—a popular digital-to-art conversion 

effect seen on the Internet recently—inspired these Actions.

iLiner series of iNovaFX Actions convert your digital image into 

several realms of artistic interpretation that go far beyond the Hayes. 

Five basic alternate approaches are provided along with a “Carnet” 

Action that runs them all. Start with only the target image appearing 

in the History Panel. It will be renamed 

“Original” by the Carnet series. At the 

end of the series you will have all eight 

variations, plus, of course, the original 

for comparison. 

iLinerCombo is a variation worthy of 

experimentation by itself.

i Some will only work well with 

certain images. All crops shown here 

are from the default Carnet results 

using a slightly light exposure.

i Note that iLiner5 expects to be run after 

the iLiner5Prep utility has been run first.
 
Special high-res demo page.
Zoom into images to see more detail! 

Five basic techniques 
produce eight final “looks.” 
Experimentation is 
encouraged.

iLiner5

iLiner4A iLiner2 

Original iLiner3A 
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Images are technically made of light, color, 
shading, sharpness, blur, framing, optical angle, 
grain, contrast, artifacts, anomalies and dynamic 
range. As you exercise dominion over each of these 
qualities, your images grow in stature.

E nhancements can take many 

forms. Some eliminate an 

attribute while others emphasize 

a characteristic. Many of the Actions seen so far 

deal with image elements you may wish to change, and the ones in this 

chapter add to that repertoire. 

Often, you won’t be aware of the need to fix, adjust or enhance an 

aspect of a shot while you are gathering it, but later, when the mood 

becomes more contemplative, some property will become noticed that 

will make you dig into these Actions looking for some help.

i Some of these require a degree of art direction or planning. You 

may have to shoot an image—or multiple images—in a way that pre-

pares it/them for a specific result.

Enhancements/Utilities
Improving the Details

Chapter 7
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iDynamicRangers
Film negatives capture highlights 

better than digital cameras do. It’s a 

fact of light. Negatives get denser with 

brighter highlights, so they hang on to 

bright gradations, but digital images 

reach a point of bleaching out—similar 

in principle to slide film.

What if you could shoot digital images 

with your camera that trounce the 

dynamic range of film? Photoshop offers 

the HDR technique, but results aren’t 

very easy—nor fast—to tweak and pro-

duce practical, intuitively clean images. 

HDR is able to do wonderful things, but 

not the one on this page.

With the iDR series, a new kind of 

appealing image can be built. It is cre-

ated from three separate exposures, 

each up to two stops apart from each 

other. The optimum shooting condition 

would be with the camera rigid from shot to shot, think tripod + remote.

i A special version (iDRv3toTaste-SelfAlign) uses the Edit > Self-align Layers 
procedure, for shots made without a tripod.

The subject must be non-moving over the span of exposures. Slow 

moving clouds may work, but fast moving features like vehicles, flags, 

animals, waves, hurricanes or kids will give poor results. 

This image looks intuitively natural. Yet it’s the product of separate -4, -2 and 0-EV images. The extreme blown-out highlight has 
been controlled with the iDRv3toTasteSuperCS3-Self-Align Action in PS CS3-CS5. Below is the “normal” exposure, its highlight detail 
completely lost to the physics of light and the tonal dynamics of digital cameras.
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The trick, is to shoot all three images 

very close together in time without 

moving camera or focus. 

Some work with over and under 

exposures, but the king of this series 

is the iDRv3toTasteSuper versions. 

These create an elaborate stack of 

image layers and Adjustment Layers, 

giving you ultimate control over each 

individual element, plus the whole 

group as a unit. This series is for high-

light extremes and starts with a normal 

image plus -2 and -4 EV captures. 

There are four variations covering 

±1-stop and ±2-stop exposure groups in 

RGB and Lab modes. 

i Only the iDRv3toTasteCS5-SelfAlign 

version allows you to do this hand held. 

If you don’t have a remote release, use the camera Self-

Timer and touch the camera lightly as you set each shot 

with hands off during the exposure.

i Manual exposure mode requires you to touch the 

camera between shots. Careful! Lock manual focus and 

don’t touch the zoom between shots.

All three shots are then brought into Photoshop and stacked over 

each other with the darkest on top and the lightest on the bottom. 

If necessary, use Photoshop’s Edit > Auto-Align Layers (Reposition) command 

before running Actions without self-alignment.

Another view from the same session started with a slightly 
lighter “normal” exposure as its base, so that exposure 
contributed more to subtle shadow detail. Below, the whole 
stack of Adjustment Layers. Each separate exposure layer 
has its own Curves and Hue/Saturation adjustment giving you 
instant control over its contribution. 
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iButterfly
Almost any picture in your library can become the 

wings of a graphic butterfly with iButterfly2.

An extra Action, iDisplayBox creates a display box 

to house an existing butterfly image. It presents a title 

under the image that is a type layer you can modify.

It’s a graphic novelty, but you will find that many 

people—especially kids—

want one made from their 

portrait. Open any image 

and run the Action. 

i The subject file must 

be the only thing open in 

Photoshop as you begin. 

After some initial housework, the Action opens the 

original subject image with a crop rectangle already in 

Transform mode. Its position, size and rotation are up 

to you. The rest is automated. Separate layers for wings, 

body, eyes and background paper will appear. Each will have its own color 

adjustment layer in one of the snapshots the Action saves. iDisplayBox adds 

type and title card layers for manual placement.

i Note that a right-facing subject works best. If your original image 

faces left, use the iFlip utility in the iButterfly folder to turn the shot to 

the right before running the iButterfly2 Action.

i An iButterfly Flattener utility lets you generate new snapshots after 

working on the multi-layered one.

i Use the iButterfly-Layers snapshot to modify the body, eye, wing 

and/or paper colors separately.

iButterfly stretches any image into butterfly wings. 
The iDisplayBox version allows you to change the 
type label to any text.
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The iButterfly2 Action produces three Snapshots in the History 
Panel. The first has each layer separate and ready for fine 
tuning. You can stop and change the color of the butterfly’s 
eyes, wings, body and background paper. Secondly, a labeled 
Snapshot is saved with the full butterfly on one layer over the 
background paper. If you switch off the visibility of the paper, 
leaving the butterfly over a transparent background, you can 
save the butterfly image in PNG-24 format, which is found in 
File > Save for Web and Devices > Preset: (PNG-24). This 
image is self-matting in many web layout or page design 
programs. The last Snapshot delivers the flattened image of the 
butterfly married to its background paper. Only the iDisplayBox 
Action adds the frame and title strip, and you have to come up 
with the title. Think Latin. Then think Road Runner.
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Photoshop comes in a second version designed for use by web page 
designers, advanced 3D artists and movie scene manipulation. It costs 
$300 more than straight Photoshop CS5. If you already own Photoshop 
Extended, here are Actions that work with HDSLR movie files. 

M ovies can be shot with today’s 
HDSLR cameras. Now what? 
HD + DSLR = HDSLR mash-up. In movie mode, 

many recent DSLRs can acquire high definition motion picture clips 

with frames as large as 1920 x 1080 pixels—about 2MP per frame. 

Photoshop Extended (PSX) facilitates working with movie files, and 

the Actions here do a number of interesting and useful things by 

combining these two ideas.

Movie scenes in Photoshop? Why not? Movies are subject to the 

same needs for imaginative treatments begged for by still images, 

but the elements of motion over time adds unique complexities. 

Digital photography is blurring the distinction between still and 

movie tools, and PSX allows you to work in two universes at once.

PhotoShop eXtended
Actions That Work With Movies

Chapter 8

PS
X
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MOVIES TO PANORAMICS

In 2010, Sony introduced pocket cameras that were able to 

capture a panoramic image by sweeping the lens in a panning 

motion, wiping a much wider image into an image file. They call 

it Sweep Panorama. Now you can do that with your HDSLR plus 

the iPanoHD Action (iPanoFromMovies folder), and get far more 

professional results, quickly. And if you want, you can capture 

360°+ images!

For panoramic images, several adjacent shots are collected. 

Traditionally you do this by methodically shooting overlapping 

still images. But now you can do it by shooting in movie mode 

with an HDSLR, then letting PSX plus an Action do the work. 

The iPanoHD Action is optimized to lift every 30th frame from 

the movie file, up to 14 panels wide. The restriction is that the 

final movie MUST be 390+ frames in length. Movie format can be 

1080p24/25/30 or 720p30. 

A pan using 720p60 will work, but less well because 

it must pan quicker showing potentially more smear. The 

orientation of the camera can be either horizontal or vertical 

and the movie clip should be shot with a high shutter speed 

(1/1000 sec or faster) to avoid blurred frames. 

i With the camera horizontal, it is fairly easy to shoot a full 

circle panoramic movie clip in 390 frames (13 seconds at 30 

fps). With the camera vertical, you would be struggling to 

shoot more than about 210° in that time.

i Best results will come from mounting the camera on a 

tripod, monopod or precision panoramic pan head. Since the 

Action is capturing only single frames, almost any tripod pan 

head (fluid not required) works quite well.

CS5 Photomerge works best when it has many images to work with. At 1080p30, the shot 
took about 15 seconds. It was captured under the most primitive conditions standing on a 
rolling dock, shooting gently rolling boats hand-held—which by rights should have polluted 
the image with a great deal of parallax error, yet only tiny stitching errors remain.
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Your capture technique is critical, but there are some guidelines that will help. 

i You can roll the camera well before panning. As you pan, start a count-

down in your head from 15, 14, 13... 0. Later, in PSX the Animation Panel 

will let you trim off any pre-panning frames.

i If you achieve the end of your pan before your count has run out, 

that’s okay, but keep recording until the time is up. The iPanoHD 

Action will ignore most redundant frames without a fuss.

i The worst shooting technique would be to move the camera in 

a wide arc in front of you. That displaces the lens, causing parallax 

between selected frames. It’s best to pivot the camera around the 

nodal point of the lens—approximately the center of the lens barrel—

as you shoot. 

i Remember that any subject moving through the scene (pets, kids, 

tourists, actors, cars) may create problems for the Photomerge feature 

in PSX. That said, PSX Photomerge is very crafty in selecting subjects 

that appear in overlap areas.

i You don’t have absolute control over the pose of people 

or moving objects in the final, but you do have control over 

your start frame. If a person or subject is in an awkward pose, 

adjust the start time, so the Action will pick a different frame 

when it gets to that part of the pan.

i When monopod shooting, here’s an advanced trick: 

Extend the pod to full height. Angle the camera down about 

2° (very slightly) so when the camera is dead level, the pivot 

point of the back-slanting monopod is under the lens, not the 

center of the camera body. This helps reduce parallax.

i Practice shooting and processing movie panoramics before you 

gather critical shots.

A big HDSLR advantage is the ability to instantly select still images, movie 
images or, in this case, a movie panoramic. Each type of image brings a 
different sort of memory. Side story: I met the late Edith Shain at an eBook 
signing. She was the nurse in Alfred Eisenstaedt’s Life Magazine photo. So 
naturally, I gave her a similar kiss. Minus some of the original passion. She 
was in her 80’s. “You’re not my first,” she said, demurely. 
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PANORAMICS WITH IPANOHD ACTIONS. 
This example uses a clip which was shot vertically. Most of your 

shots will probably be horizontal panoramics, but this shows how 

either orientation will work with the Action iPanoHD.

1.	 Close all other Photoshop files and Open the movie panoramic 

file. You may need to spin a vertical capture 90° to cause the 

movie file to be oriented correctly. Not all cameras present verti-

cal movies in a vertical window. Two utility Actions, iTwist90CW 

and iTwist90CCW* make this a snap.

2.	 Open the Animation Panel and change it to timeline mode, if it 

is not already in the form at right (red oval). In the upper right 

corner of the Timeline Panel (green oval), a panel-specific menu 

icon lets you open settings turning the time into 

frames and allowing you to adjust the timeline’s 

scene icon to Large, as has been done here. Those 

settings simplify the next operations.

3.	 With your cursor, you can click on the green timeline 

bar and slide it left or right. Here we have moved it to 

the left to trim off some of the head of the clip before 

the camera started its pan. You will need at least 390 

frames, so you can move the End Of Work Area Indicator to that 

point and slide the Current Time Indicator there to confirm the 

condition for your end frame. 

i One Action does horizontal and vertical images, and smooths 

the edges adding a drop shadow as in the iPanoCylinderEdge 

sets of Actions. Optionally twist vertically shot scenes using the 

iTwist90CW or iTwist90CCW utilities before running iPanoHD.

When you turn a 16:9 frame vertically, it looks quite tall. Here are the start and end 
frames from a hand-held slow pan of about 200° with the camera held vertically. 
The Animation Panel’s timeline mode allows easy shifting of the full clip to the 
left, to trim off repetitious start frames captured before the pan began. The initial, 
uncropped result is at the top of the next page.

* CW=clockwise; CCW=counter clockwise.
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4.	For this shot, a 1080p30 HD file, we used 

iTwist90CW to make the image read correctly on 

screen. Any frame rate will work, as long as the 

total frames are 390+. The Action stops to let you 

make adjustments, but the above step 3 already 

completed those, so you can Continue past all alert 

windows with simple carriage returns.

5.	Before the Action completes, it has automatically 

generated a cylindrical panoramic image, and 

if it is a vertical pan—say, up a building—it will 

have magically twisted the image 90 degrees to 

work on it. It will smooth the edges and add a 

drop shadow, pausing so you can place, scale 

and tune the shadow to taste.

Along the way, several layered Snapshots will appear 

in the History Panel ready for tweaking. 

1. The first multi-layer pano assembly, 

2. The flattened smooth edge layered version and 

  3. The final version with drop shadow.

i Want to change the shadow? Re-open the fx item 

and re-adjust it.

i Want a rectangle instead of a bubble? Crop to 

the maximum as we did in the bottom example here 

and on pages 248 & 249.

i You can use these Actions with vertical iPhone 4 

HD shots, but you may need to twist the movie files 

90° to horizontal before importing them to PSX.

All these were shot within moments of  each other in San Diego. The top three show how 
they emerged before cropping. The impossible-to-find-a-place-to-put-your-car shot (Parking 
Lotto) is over 340°. If you obtain a full 360° sweep, you will be surprised to see that you 
have no control over where the shot ends occur. Photomerge doesn’t differentiate its first 
and last images. PSX will arbitrarily decide for you. So try to shoot slightly less than full 
circles, unless it is not critical to your use.
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PHOTOSHOP’S TRICKIEST SECRET
When you open a RAW image, it 

appears in the Raw Interpreter Panel, 

and a comprehensive array of tools 

are immediately at your fingertips. 

You can change exposure, add 

fill light for shadow detail, control 

blooming highlights, level, lens 

correct, sharpen, color adjust and 

dozens of other things.

Wouldn’t it be nice to have this 

suite of tools for immediate manipu-

lation of all your JPEG images as you 

open them? 

You can. 

But it’s so well hidden you will 

need to tell PS CS5 exactly how to 

do that for you.

Open Preferences (Command + K or Control + K) > File Han-

dling > File Compatibility > Camera Raw Preferences > JPEG 

and TIFF Handling > JPEG: > (Automatically open all supported 

JPEGs). By my count that’s tucked away no less than six layers 

deeper than anything obvious. But now every time you drop a 

JPEG image onto your Photoshop icon, it will pop open using the 

Raw Interpreter Panel.

i The only downside: You must confront the image(s) and use 

the Raw Panel to complete the idea of opening them every time.

One window; a billion possibilities. The Raw Interpreter Panel delivers 
more image manipulation tools into your immediate control than anything 
else. Here it has opened three JPEG images at once from two different 
cameras. You can select them all and give them all the identical settings, 
if you wish, for an instant batch processing. Here the top image has 
been Leveled (angle), Exposure adjusted +15% of a stop, and a small 
amount of Fill has been added to dark shadow areas. With practice, 
you can perform enhancements, corrections and improvements on your 
images before opening them in the main Photoshop window. Be aware, 
though, that JPEGs won’t tolerate the large corrections that RAW files 
comfortably enjoy. 
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Index

Symbols
2¼ by 2¼  60
4 image printing  70
4x5 sheet film  65
4x5 view camera  60
6x6 format  60
16 image printing  72
35mm borders  67
720p60  255, 258

A
A4 Letter  71
Action Anatomy  15
Action Creation  39
ActionsCS5  3
Action Shortcuts  9
Actions Panel  55
Adams, Ansel  6
Adjustment Layers  226, 227
Adobe After Effects  259
Adobe Premiere  259
Adobe Reader  4
Airbrush effect  209
Amplification  14
Ansel Adams  6
APS-C  173
Array images  178
Aviator (movie)  212

B
Background/Foreground colors  266
Barrel distortion  39–170
Barrel distortion batch correction  176
Barrel distortion correction  174
Bayer  16
Blending Mode  19, 260
Bloom art effect  206
Blown pixels  192, 276
Borders  59
Butler, Linda  214
Butterfly Actions  243–244
Button Mode  21
B&W conversion  217
B&W filters  215

C
Canvas Size  45
Canvas Size tool  139
Carnet  196, 216
Carnets  9
Caveats  62, 63, 64, 65, 67, 69, 71, 73, 159, 176, 224 

261, 263
Channel Mixer  236
Chromatic aberration  26
Color blast effect  203
Color filter simulators for B&W conversion  215
Complex Action Recording  48
Conté Crayon movie effect  267
Conté Crayon still effect  125

Click on page numbers to jump directly to that page.
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Contents  5
Continue  21
Conversions  14
Cooler / Warmer  185
Corrective Actions  32
Corrective measures  171–194
Create Simple Action  43
Crops  228
Crop utility  228
Cross Star Filter for movie  263
Cross Star filters  160
CSI Miami  272
Curves  184
Curves control  50
Cylindrical edge repair  177

D
De-Noise  188
Digimarc  94
Digital Camera  3
Digital Intermediate  210
Dimroom art effect  205
Distortion lens effect  166
Domino  213
Dreamy color effect  203
Dust Reference Frame  194
Dust & Scratches Filter  120
DX format  173, 231
Dynamic range enhancement  220–222

E
Easy Barrel Correction  41
Edge Fog effect  62
Equalization  200
Equisolid  231
Errors  13
Exporting Action-processed movie files  277
Extreme ISO  191
Extrude Filter  139
Eyedropper tool  184
Eye of the Beholder  6

F
Film Strip  68
Filters  14
Final Cut Studio  259
Fingerprint  237
First Photo  17
Fisheye  38
Flaw Frame  192
Flesh tone B&W  207
Fog filter  157
Foreword  3
Four image print  70–71
Four thirds (format)  173
Framing Actions  33
Full frame 35mm  173
Full STOP  21
FX format  173
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G
Geometry Repairs  172
Giant images  178
Giant poster  245
Giottos Rocket  193
Glass filter equivalents  151–168
Golden Section  234
Gradation filters  153
Grad filter Actions  33
Grad filter effect  260
Grading, movie  269
Grad Layer  154
Graphic  209
Graphic flattening  265
Graphic Photo Fantasies  37

H
Halo filter  159
Handwritten fonts  201
Hayes Island Effect  196
HDR  220, 222
HDSLR  247, 248, 252, 275
High ISO  188, 192
History Lesson  57
History Panel  12, 18–170, 26–170, 29–170, 30–170, 

46, 54–170, 56–170, 57, 106–170, 201, 207, 209, 
213

Hue/Saturation  198, 211

I
iBaby Action  166
iCrAb  26, 27
iFourPrint  70
iGraphic Action  209
iHalcyon  264
iMovieBrighten  268
iMovieDarken  268
iMovieDeNoise  274
iMovieGamma  269
iMovieGrade  269
InfoBites  10
Infrared filter effect  163
iNovaChrome  61
iNovaFX  13, 14, 184
iNova, Peter  2–4
In-register FX  19
Installing Actions  31
iOldTymie Action  229
iPad  4
iPSBrushStrokes  95
iPSDistort Series  105
iPS+Noise Series  120
iPSSketch Series  121
iPSTexture Series  145
ISO boosting  190–191
iStylize Series  138
iTimeLapseMaker  262
iToons  208
iToy Action  167
iVintageCS5  264
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J
JPEG artifacts  187

L
Law Of The Haircut  33
Layer effects  20
Less is more  209
Lights  3
Limitations  14
List View  21, 44
Load Actions  11
Local Contrast  204

M
Meet the Actions  7
Miller, Frank  211
Miniature scene effect  167
Monochrome  207, 214, 215, 218, 236
Monopod  249
Motion 4  259
“Moustache” curve  41
Moustache distortion  175
Movie Drawings  266
Movie Flaw repair  276
Movies  247
Movie scene flicker Repair  262
Multiple Images on a page  34

N
NASA  230
New Snapshot  54
Niépce, Joseph Nicéphore  17

O
Opacity  56, 155, 190
Optical filter actions  33
Optical Flow  259

P
Panoramic  58
Panoramic image  248
Panoramics  177
PDF  4
Pencil line  202
Pencil sketch  201
Perspective  182
Perspective repair  181
Perspective tutorial  182–183
Photography As An Effect  16
Photomerge  31, 58, 176, 177, 178, 249
Photoshop CS5  3, 20
Photoshop Extended  9, 247
Photoshop Filters +++  75–150
Photoshop FX Actions  35
Photoshop’s Trickiest Secret  278
Pinch  41
Polar Coordinates  238
Polarization filter effect  162
Portraits  242
Posterization  265
Preface  11, 39, 59, 75, 171, 195, 219
Preferences  278
Printing dots  232
Print Preparation Actions  36
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PS Artistic  77–94
PS Brush Strokes  95–104
PS Distort  105–116
PS Pixelate  117–119
PS Plus Noise  120
PS Sketch  121–137
PS Stylize  138–144
PS Texture  145–150
PSX  247

R
RAW format  222
Raw Interpreter Panel  278
Reader Shortcuts  9
Reference Point Locator  24
Restarting  22
Retinex effect  230
Rodriguez, Robert  211
Roll film Actions  61
Roll film borders  60
Rolling shutter  252
Rule Of Thirds  234

S
Save Actions  55
Scratch filter  161
Screen Blending Mode  19
Selective blur  261
Shatter glass effect  164–165
Sheet Film Border  65
Sin City (movie)  211
Sixteen image printing  72–73
Slide film  220
Slit-Scan Photography  252
Smart Sharpen  275
Smith and Boyle  16
Snapshot  216
Sodium lighting  185
Spherize  41
Spiderwebbing  187
Stamp out images  69
Storytelling  13
Sweep Panorama  248

T
The Aviator (movie)  212
Theory of adjustment  24
“The Primate Limit”  12
Three Hints  6
Traction from your Action  56
Twixtor  259
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U
Unsharp Mask  204
US Letter  71

V
Vibrance Adjustment Layer  272
View camera corrections  181
Vignette effect  170
Vignetting  270
Visual Effects Actions  35

W
Warmer / Cooler  185
White card  194
Why this eBook?  3

Z
Zoom lenses  172
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